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Micronics Quick Installation

We know many experienced people prefer to read as little of the documenta-
tion as possible.  If this sounds like you, here’s the short form:

1. Ground yourself to prevent damaging static discharge, then remove the
LPM30 from its packaging.

2. Check the voltage of your CPU and install a Power Module, if necessary.
See Chapter 2 for information on whether or not you will need a Power
Module.

Warning:
This system board has been factory set to support 5.0V processors.  If
using a 3.3V or 4.0V processor, you must install a Power Module
(Appendix E).  Failure to install a Power Module could result in
damage to the CPU.

3. Configure and verify the system board’s jumper settings.  (See Jumper
Settings in Chapter 2)

4. Install the CPU and the system memory.  (Chapter 3)

5. Install the motherboard into the system case and make all of the necessary
case connections.

6. Install a riser card (if needed).  Install any peripherals or peripheral
cards.  Connect the power cords, the monitor, the mouse, sound devices,
and any other external  peripherals to the appropriate port (Chapter 3).
Do not replace the computer cover until you have verified the system is
working properly.
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7. Turn the computer on and press the <Ctrl>, <Alt>, and <Esc> keys
simultaneously after you see the screen below:

8. Set the time and date.  Adjust the BIOS settings to match what is installed
in your system.  If installing an IDE drive, select the IDE device you wish
to configure.  Select AUTO CONFIG and the BIOS will automatically
configure the drive for you.  (Chapter 4)

9. After you have configured the BIOS settings,  press the <Esc> key
followed by the <F4> key to save the changes and exit.  The system will
reboot.

10. Install the video drivers provided with the system (Chapter 5 and 6).

11. If you are installing a CD-ROM, install the drivers that came with the CD-
ROM.  (Refer to the documentation which came with the CD-ROM).

12. Run the SoundDrive 16 software drivers (Chapter 7).

13. The system is ready for use.

Click here to continue
to the T.O.C......
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1 Introduction

The LPM30 is an integrated, low-profile, LPX system board which
allows you to create a multimedia system without any add-in cards o
IRQ/DMA hassles.  The LPM30 features VESA Localbus architecture
Mode 3 IDE controller, 16-bit Sound Blaster compatible sound, and 6
bit graphics. The Micronics LPM30 system board represents Microni
third generation of VESA Local Bus system boards and makes an
excellent foundation for an advanced personal computer or workstat

Micronics is a forerunner in VESA Localbus technology. The VESA
Localbus Architecture provides high performance for Graphical User
Interfaces (GUIs) and peripherals that perform high speed data trans
such as disks and multimedia.

The LPM30 is also a “Green Board”  which means it adheres to the
Environmental Protection Agency’s strict Energy Star efficiency
guidelines.  The Green features are not available when a DX4-
100MHz is installed.  See Chapter 4 for information and instructions o
how to set up the “Green Section” of the BIOS.
1-1
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Features

The LPM30 includes the following features:

m LPX form factor system board.

m Micronics’ X30 chipset with an on-chip external level 2 cache controlle

m   One VL slot built onto the system board.  Slot will accommodate a rise
card which supports up to one VESA and four ISA peripheral cards.

m  On-board VESA Localbus video adapter, using the 64-bit ATI mach64
graphics accelerator with 1MB of VRAM (2MB optional).

m   On-board 16-bit sound controller.

m   On-board feature connectors accept:
14,400 Faxmodem module (optional).
Ethernet network adapter module (optional).
3.3V and 4.0V power modules for low voltage CPU’s.

m   Accepts up to 256K of external cache.

m   On-board Localbus IDE controller.

m Floppy controller (supports 2.88MB, 1.44MB, 1.2MB, 720K, and 360K
floppy drive).

m Two high speed 16550 compatible serial ports.

m Bi-directional parallel port which is EPP and ECP compatible.

m Battery-backed real-time clock.

m Supports the following processors in the CPU ZIF socket:

- 486SX2, 50MHz
- 486DX, 33MHz
- 486DX2, 50 or 66MHz
- 486DX4, 75 or 100MHz
- Cyrix DX2/80 or DX/40
- AMD DX40, DX2/80, or DX4/100
1-2
Click here to continue
to the next chapter.....
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2 Configuring the LPM30

Although the LPM30 system board is packaged in protective materia
it is important to use care while unpacking and setting up.

Static Electricity
The LPM30 is shipped from the factory in an antistatic bag.  To reduc
the possibility of damage, it is important to neutralize any accumulate
static charges on your body before handling the board.  The best wa
do this is to ground yourself using a special wrist or ankle strap.  If yo
do not have a strap, you should touch both of your hands to a safely
grounded object.  After you have grounded yourself, ground the LPM
via the solder pads surrounding one of its mounting holes.

Once the LPM30 is removed from its packaging, place it on top of the
antistatic bag.  Carefully inspect the board for damage which may ha
occurred during shipment.

Office Environment
Make sure the finished computer system is in an area with good ven
tion.  The system should not be in direct sunlight, near heaters, or
exposed to moisture, dust, or dirt.
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LPM30 Components

Figure 2-1  LPM30 System Board
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Warning:
This system board has been factory set to support 5.0V processors.  If usi
a 3.3V or 4.0V processor, you must install a Power Module (Appendix E).
Failure to install a Power Module could result in damage to the CPU.

Table 2-1 lists the voltage requirements for CPUs supported by this system
board.

CPU Manufacturer(s) Voltage
486SX Intel, AMD 5.0V
486DX Intel, AMD 5.0V
486DX2 Intel 5.0V
486DX2 AMD 3.3V or 5.0V
486SL-series Intel 5.0V
Write-Back Enhanced 486DX2 Intel 5.0V
486DX4 Intel, AMD 3.3V
Pentium OverDrive Intel 5.0V
Cyrix 486DX/DX2 Cyrix 5.0V
Cyrix 486DX2V-80 Cyrix 4.0V

Table 2-1  CPU Voltage Requirements
2 - 3
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Jumper Settings

Table 2-2 and 2-3 list the settings to select the CPU installed in your system

CPU W22 W23 W30 W31 W32 W33 W34
486SX 2-3 1-2 2-3 2-3 2-3 open open
486DX/DX2 2-3 1-2 1-2 & 3-4 2-3 2-3 open open
486SL-series 2-3 1-2 1-2 & 3-4 2-3 2-3 open open
Intel Write-Back
Enhanced 486DX2

1-2 1-2 1-2 & 3-4 2-3 1-2 close 1-2

486DX4 2-3 1-2 1-2 & 3-4 2-3 2-3 open open
Pentium OverDrive 1-2 1-2 1-2 & 3-4 2-3 1-2 open open
AMD 486DX/DX2 2-3 1-2 1-2 & 3-4 2-3 2-3 open open
AMD DXL4 2-3 1-2 1-2 & 3-4 open 2-3 open 2-3
Cyrix 486DX/DX2 1-2 2-3 1-2 & 3-4 1-2 2-3 open 1-2

Table 2-2  CPU Jumper Settings

CPU W35 W38 W40 W41 W43 W44 W45
486SX open 3-4 4-5 3-4 1-2 open open
486DX/DX2 open 3-4 4-5 3-4 1-2 open open
486SL-series 1-2 3-4 4-5 3-4 1-2 open open
Intel Write-Back
Enhanced 486DX2

2-3 3-4 4-5 1-2 &
3-4

1-2 open open

486DX4 open 3-4 4-5 3-4 1-2 open open
Pentium OverDrive open 2-3 1-2 3-4 1-2 open open
AMD 486DX/DX2 open 1-2 & 3-4 4-5 open 1-2 close 1-2
AMD DXL4 open 1-2 & 3-4 4-5 open 1-2 close open
Cyrix 486DX/DX2 open 3-4 2-3 2-3 2-3 open open

Table 2-3  CPU Jumper Settings (Cont’d.)

Note:
If you are using a 3.3V or 4.0V processor, you will need to install a special
Power Module.  See Appendix E for more information.
2 - 4
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Table 2-4 lists the jumper settings to select the speed of the CPU insta
your system.

                             Speed
Jumper

25MHz 33MHz
(default)

40MHz

W26 open open close
W27 open close open

Table 2-4  CPU Speed Selection

Table 2-5 lists the jumper settings to select the size of the external cach

Jumper Function Setting
W39 128K

256K
1-2 & 3-4
2-3 & 4-5

W42 128K
256K

open
close

Table 2-5  External Cache Size Selection

Table 2-6 lists the jumper settings to enable or disable the IDE controlle

Jumper Function Setting
W28 Enable IDE controller (default)

Disable IDE controller
1-2
2-3

Table 2-6  Enabling the IDE Controller

Table 2-7 lists the jumper settings to enable or disable the on-board I/O
controller.

Jumper Function Setting
W11 On-board I/O enabled (default)

On-board I/O disabled
open
close

Table 2-7  Enabling the I/O Controller
2 - 5
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Table 2-8 lists the jumper settings to enable or disable the game port.

Jumper Function Setting
W2 Game port enabled (default)

Game port disabled
close
open

Table 2-8  Enabling the Game Port

Table 2-9 lists the jumper settings to set the parallel port for IRQ7 or IRQ

Jumper Function Setting
W5 IRQ7

IRQ5
1-2
2-3

Table 2-9  Parallel Port IRQ Selection

Table 2-10 lists the jumper settings to select the DMA channel for the par
port ECP/EPP mode.

DMA Channel
Jumper

None
(default)

DMA1 DMA3

W6 open 1-2 2-3
W10 open 1-2 2-3

Table 2-10  ECP/EPP Mode DMA Selection

Table 2-11 lists the jumper settings to select the type of video installed.

Jumper Function Setting
W1 Color monitor (default)

Monochrome monitor
close
open

Table 2-11  Video Selection
2 - 6
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Table 2-12 lists the jumper settings to enable or disable the on-board 
controller

Jumper Function Setting
W14 On-board VGA enabled (default)

On-board VGA disabled
open
close

Table 2-12  VGA Controller Selection

Table 2-13 lists the jumper settings to enable or disable VGA controlle
feature connector.

Jumper Function Setting
W15 RAMDAC enabled (default)

RAMDAC disabled/Feature enabled
open
close

Table 2-13  Enabling the VGA Feature Connector

Table 2-14 lists the jumper settings to enable or disable the on-board 
controller.

Jumper Function Setting
W4 On-board sound enabled (default)

On-board sound disabled
open
close

Table 2-14  Enabling the On-Board Sound Controller

Table 2-15 lists the jumper settings to set the sound controller’s addre

Jumper Function Setting
W3 On-board sound address 240 (default)

On-board sound address 220
1-2
2-3

Table 2-15  Sound Controller Address Selection
2 - 7
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Table 2-16 lists the jumper settings to set the sound controller’s IRQ.

Jumper Function Setting
W7 On-board sound IRQ5 (default)

On-board sound IRQ9
1-2
2-3

Table 2-16  Sound Controller IRQ Selection

Table 2-17 lists the jumper settings to set the sound controller’s DRQ

DRQ Setting
Jumper

DRQ0 DRQ1
(default)

DRQ3 None

W8 1-2 2-3 1-2 2-3
W9 2-3 1-2 1-2 2-3

Table 2-17  Sound Controller DRQ Selection

Table 2-18 lists the jumper settings to enable or disable the buzzer.

Jumper Function Setting
W20 Buzzer enabled (default)

Buzzer disabled
close
open

Table 2-18  Buzzer Selection

Table 2-19 lists the jumper settings for BIOS operation.

Jumper Function Setting
W18 Flash BIOS write protected (default)

Flash BIOS programmable
open
close

Table 2-19  BIOS Operation Selection
2 - 8
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Table 2-20 lists the jumper setting to reset the CMOS.  With the compute
power off, move the jumper to pins 2 and 3 for about five seconds and p
the jumper back on pins 1 and 2.

Jumper Function Setting
W25 Normal Operation (default)

Reset CMOS
1-2
2-3

Table 2-20  CMOS Reset Jumper

Table 2-21 lists reserved jumper settings.  Do not reconfigure these jumpers.

Jumper Function Setting
W13 Reserved 1-2
W17 Reserved open
W19 Reserved 1-2 & 3-4
W21 Standard 5V DRAM

Micron 12V DRAM
open
close

W29 Reserved 2-3

Table 2-21  Reserved Jumpers
2 - 9
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Table 2-22 lists the jumper settings for case and peripheral connecti

Jumper Function Notes
J15 VL IDE Connector Primary
J16 ISA IDE Connector Secondary
J17 Floppy Connector
J2 VGA Connector
J12 Parallel Port Connector Can be disabled in

CMOS.
J5 Serial Port (Com 1) Can be disabled in

CMOS.
J7 Serial Port (Com 2) Can be disabled in

CMOS.
J1 Game Port
J4 PS/2 Keyboard
J3 PS/2 Mouse
J10 LAN Connector Contact Micronics

to order
J11 Modem Connector Contact Micronics

to order
J14 & J18 Power Supply Connectors

SPKR Speaker Sound Controller
LINE OUT Line Level Output Sound Controller

LINE IN Line Level Input Sound Controller
MIC IN Microphone Input Sound Controller

J8 Audio Connector Connect to CD-ROM
J20 Speaker Connector 1-Speaker; 2-N/C; 3-

Ground; 4-5V DC
J22 Turbo LED 1-5V DC; 2- Ground
J23 Turbo Switch
J24 Reset
W36 HD LED 1-5V DC; 2- Ground
J19 Keylock/ Power LED 1-Power; 2-N/C; 3-

Ground; 4-5V DC
J21 Power Module Connector See Appendix E

Table 2-22  Case and Peripheral Connections
2 - 1 0

Click here to continue
to the next chapter.....
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Installing the LPM30, System
Memory, CPUs, and
Peripherals

This section explains how to install the LPM30 system board,  SIM
CPUs, and peripherals.

Warning:
Before installing or removing any peripherals or components, mak
sure you have a clear work space and that you adhere to all anti-s
precautions described on page 2-1.  Micronics recommends that o
trained technicians operate on the system board.  Damage which
occurs to the board while adding or removing peripherals or comp
nents may void the warranty.

If problems arise while installing peripherals, contact the computer
outlet where you purchased the peripheral or Micronics’ Technical
Support Department.
3-1
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Installation of the LPM30

The installation of the LPM30 system board depends on the type of case 
use.  The LPM30 is an integrated, low profile LPX system board which sh
be limited to installation in a low profile chassis.

Prior to installing the LPM30, make sure you have a clear work space ava
able and adhere to all anti-static precautions.

If you are unfamiliar with installing a system board, Micronics highly recom
mends you read the computer user’s manual or contact your dealer’s tech
support department.

Tools Required
Micronics recommends using the following tools to install the LPM30:

m Small Phillips screwdriver.

m Tweezers or a pair of needle-nose pliers.

m Tray (to hold loose screws).

Equipment Required
Micronics recommends using the following equipment with the LPM30 for
typical configuration:

m LPX or Low Profile Chassis.

m A high quality power supply capable of providing continuous power
within a 5 volt range, plus or minus 5% (eg., 4.75 to 5.25).  A power
filter may be used with a noisy AC power source.

m PS/2 style keyboard and mouse.

m Eight ohm speaker.

m Standard ribbon cables for internal connections.

m Standard power cord (grounded).

m Heat sink with cooling fan.
3-2
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System Memory

System memory devices, commonly known as SIMMs (Single Inline Mem
Modules) are necessary to operate the LPM30 system board.  The LPM3
four SIMM sockets and can be upgraded to 128 Megabytes of RAM.  This
section will explain the type of SIMMs supported, list the memory configur
tions supported, and show how to physically install the new SIMMs.

SIMMs Supported
The LPM30 supports the following 72 pin, 60 or 70ns SIMMs:

4MB (1Mx36 or 1Mx32)
8MB (2Mx36 or 2Mx32)
16MB (4Mx36 or 4Mx32)
32MB (8Mx36 or 8Mx32)

Note:
For long term reliability, Micronics recommends using SIMMs with tin-plate
contacts.  The use of gold-plated contacts may conflict with the tin alloy o
SIMM socket.
3-3
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Memory Configurations
The following table (Table 3-1) lists the most common memory configurati
supported.

Memory Bank 0 Bank 1 Bank 2 Bank 3
4MB 1MBx36
8MB 2MBx36
8MB 1MBx36 1MBx36

12MB 1MBx36 1MBx36 1MBx36
16MB 1MBx36 1MBx36 1MBx36 1MBx36
16MB 4MBx36
16MB 2MBx36 2MBx36
24MB 2MBx36 2MBx36 2MBx36
24MB 2MBx36 2MBx36 1MBx36 1MBx36
32MB 8MBx36
32MB 4MBx36 4MBx36
32MB 2MBx36 2MBx36 2MBx36 2MBx36
40MB 4MBx36 4MBx36 1MBx36 1MBx36
48MB 4MBx36 4MBx36 2MBx36 2MBx36
48MB 4MBx36 4MBx36 4MBx36
64MB 8MBx36 8MBx36
64MB 4MBx36 4MBx36 4MBx36 4MBx36
72MB 8MBx36 8MBx36 1MBx36 1MBx36
80MB 8MBx36 8MBx36 2MBx36 2MBx36
96MB 8MBx36 8MBx36 8MBx36
96MB 8MBx36 8MBx36 4MBx36 4MBx36
128MB 8MBx36 8MBx36 8MBx36 8MBx36

Table 3-1  Common Memory Configurations
3-4
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Installing the SIMMs
To install the SIMMs, locate the SIMM sockets on the system board.

Start with bank 0 and perform the following steps to install the SIMMs:

1. Hold the SIMM so that the notched edge is aligned with the notch on
the SIMM socket (Figure 3-1).

2. Insert the SIMM at a 45 degree angle.

3. Gently push the SIMM into an upright position until it locks into
place (past the release tabs).

Figure 3-1  Installing a 72-Pin SIMM

Removing SIMMs
Perform the following steps to remove SIMMs, if necessary:

1. With both thumbs (or fingers), press the release tabs away from the
socket.

2. With the SIMM free from the release tabs, lift the module up and
place in an anti-static bag or package.
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Installing a CPU

The LPM30 is specifically designed to support a large variety of CPU’s from
Intel, AMD, and Cyrix.  To install an upgrade processor, perform the follow-
ing steps:

1. Locate the ZIF socket on the board (Figure 3-2).

2. Lift the lever of the socket.

3. Insert the new processor into the socket.  Make sure pin 1 on the CPU
lines up with pin 1 on the socket.  Refer to Figure 3-2 for pin 1
location.

4. Push the lever down to its original position.

5. Configure the board using the tables in Chapter 2.

The new CPU is now ready to operate.  The system board detects the insta
CPU after it is inserted and configured.

Figure 3-2 Installing a CPU

Warning:
If the new processor includes a heat sink or cooling fan, be certain to instal
the device according to the manufacturer’s instructions.  Failure to provide
adequate cooling of the processor may seriously affect system performanc
or cause permanent damage.
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Upgrading to 256K of Cache Memory

To upgrade to 256K cache, carefully install four 32Kx8-15ns SRAMs into t
open SRAM sockets on the lower right-hand corner of the system board
(Figure 3-3).  After installing the cache upgrade, refer to Table 2-4 for the
correct external cache jumper settings.

Figure 3-3  Upgrading to 256K External Cache
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Video Memory - Upgrading to 2 MB

The LPM30 comes standard with 1MB of video memory.  To upgrade to 2
of video memory, install 256Kx16-60ns video memory chips into Socket U
and Socket U23 (Figure 3-4).

Figure 3-4  Upgrading to 2MB of Video RAM

Note:
Make sure the notches on the video memory match the notches on the so
3-8
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Installing a VL-Bus Riser Card

To install the LPM30 VL-Bus riser card, perform the following steps:

1. Locate the LPM30’s slot (refer to Figure 2-1).

2. Make sure no peripherals are installed on the riser card.

3. Insert the card with the bottom edge level.  Never insert the card at
an angle.

4. Holding the card at the center of the top edge, gently push straight in.
Do not force the card.  If it does not fit, take it out and try again.

5. Make sure the card is fully inserted and use the case screws to secure
the riser card in place.

Figure 3-5  Inserting the LPM30 VL-Bus Riser Card
3-9
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Installing a VL-Bus Peripheral Card

Micronics VL-Bus slots accommodate all VL-Bus cards which meet the
VESA specifications.  Complete the following steps to install a VL-Bus car

1. Turn the computer system off and remove the cover.

2. Choose an unused VL-Bus slot on the riser card and remove the slot
cover.

3. Insert the card with the bottom edge level to the slot.  Never insert the
card at an angle!

4. Carefully push the card straight in while securing the other side of the
riser card with your free hand.  Make sure the card is fully inserted.

5. Replace the screw which holds the card into place.

6. Replace the cover.

7. Read the card’s manual for additional instructions concerning installat
and software drivers.

Figure 3-7  Installing a VL-Bus Peripheral Card
3-10
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Installing System Memory and Add-On Peripherals
Installing an ISA Peripheral Card

Micronics ISA slots accommodate all standard ISA peripherals.  Comple
following steps to install a ISA card:

1. Turn the computer system off and remove the cover.

2. Choose an unused ISA slot on the riser card and remove the slot co

3. Insert the card with the bottom edge level to the slot.  Never insert the
card at an angle!

4. Carefully push the card straight in while securing the other side of th
riser card with your free hand.  Make sure the card is fully inserted.

5. Replace the screw which holds the card into place.

6. Replace the cover.

7. Read the card’s manual for additional instructions concerning install
and software drivers.

Figure 3-8  Installing an ISA Peripheral Card
3-11
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Connecting Devices to the Sound Controller

In order to take advantage of the on-board sound controller, it is necessary
connect external devices to the LPM30.

Figure 3-10  Connecting External Devices to the Sound Controller

External Speakers
You can connect 4 or 8 ohm external speakers or headphones to the
SoundDrive 16 audio controller. The speakers and headphones plug into th
Speaker jack on the back of the LPM30.

Joystick
Plug the joystick into the 15-pin connector on the back of the LPM30.

MIDI
If you purchased the optional MIDI interface kit, you will have an additional
cable.  This cable plugs into the 15-pin connector and provides MIDI IN and
MIDI OUT connections, in addition to a joystick connection. Connect this
3-12
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Installing System Memory and Add-On Peripherals
cable to the joystick port and connect any MIDI devices to the appropriat
cables.

Microphone
You can connect a 300-600 ohm microphone to SoundDrive 16 audio co
ler.  Plug it into the MIC jack on the back of the LPM30.

Line In
You can connect an external mono or stereo audio source to the SoundD
16 audio controller, such as a tape player or radio.  Use the appropriate
converter cable to interface to your external equipment.

Line Out
Allows you to connect the audio output of the SoundDrive 16 audio contr
to your home stereo, VCR, or amplified speakers.

Installing the Optional Faxmodem Module

The LPM30 supports an optional faxmodem module which can be ordere
from your dealer or directly from Micronics at (510) 651-2300.

Before installing the fax module, it is important to remove the knockout o
back of the case so it may be plugged into the phone outlet (Figure 3-11)

Gently press against the knockout from the inside of the case until it is
perpendicular to the back of the case.  Wiggle the knockout up and down
it breaks free.

Figure 3-11  Removing the Faxmodem Module Knockout
3-13
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After you have removed the knockout, follow the steps below:

1. Refer to the antistatic precautions described on page 2-1.

2. Read the faxmodem module’s user manual and configure it for
installation.

3. Turn the computer system off and remove its cover.

4. Locate the fax connector illustrated in Figure 2-1.

5. Insert the module with the bottom edge level to the connector (Figure
3-12).  Never insert the module at an angle!

6. Carefully push the module straight down, making sure it is fully insert

7. Replace the computer cover.

Figure 3-12  Installing the Faxmodem Module
3-14
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Installing the Optional Ethernet Module

The LPM30 supports an optional Ethernet module which can be ordered 
your dealer or directly from Micronics at (510) 651-2300.

Before installing the module, it is important to remove the knockout on th
back of the case so the 10 BASE-T connector may be connected to the
network (Figure 3-13).

Gently press against the knockout from the inside of the case until it is
perpendicular to the back of the case.  Wiggle the knockout up and down
it breaks free.

Figure 3-13  Removing the Ethernet Module Knockout

After you have removed the knockout, follow the steps below:

1. Refer to the antistatic precautions described on page 2-1.

2. Read the Ethernet module’s user manual and configure it for
installation.

3. Turn the computer system off and remove its cover.

4. Locate the Net connector illustrated in Figure 2-1.

5. Insert the module with the bottom edge level to the connectors (Figu
3-14).  Never insert the module at an angle!

6. Carefully push the module straight down, making sure it is fully inser

7. Replace the computer cover.
3-15
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Figure 3-14  Installing the Ethernet Module
Click here to continue
to the next chapter.....
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4 The BIOS Setup Utility

Configuration

After the LPM30 system board and all hardware is installed, the sys
is ready for configuration.  Before turning on the computer, make su
all cables are correctly connected and all jumpers are correctly set.

It is recommended you keep the computer cover off the first time yo
boot the system.  If you have any difficulties, they will be easier to
correct.

Initial Boot Up

Power up the LPM30.  If the system doesn’t properly boot, check all
your cables and peripherals for bad connections.  You may also get
messages or beep codes.  If this occurs, consult Appendices A and/
for a guide to possible solutions.

After the system properly boots, it is ready for configuration.  The
following pages explain the proper procedures for BIOS configuratio
4-1
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Setup

The Setup procedure is built into the system.  Setup begins after the syste
powered up.  Once the system is powered up and goes through a memory
the following screen appears on your monitor:

Figure 4-1  Power-Up Screen

If the systems detects a configuration error, it displays an error message.  
the error message, another message displays indicating the choice to “pre
<F1> to continue (boot up), or <F2> to run the Setup procedure.”  Normall
you will press <Ctrl>, <Alt>, and <Esc> simultaneously to begin the Setup
procedure.

Running the Setup Procedure

Upon pressing <F2>, the CMOS Main Screen (Figure 4-2) will appear and
prompt will be on the time line.  If the Power-Up Screen does not appear b
DOS prompt does (i.e., A:\ or C:\), press the <Ctrl>, <Alt>, and <Esc> keys
simultaneously to begin the Setup procedure.
4-2
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The LPM30 system board has two CMOS configuration screens: the Main
Screen (Figure 4-2) and the Extended Screen (Figure 4-3).  To toggle betw
the screens, press the PgUp/PgDn keys.

Figure 4-2  CMOS Main Screen

Now, configure the parameters to match your specific requirements.  See 
following pages for procedures on how to set the computer’s parameters.

To change or view any of these parameters, press <Ctrl>, <Alt>, and <Esc
simultaneously.  This can be done at any time, but it is recommended afte
rebooting the system.

Setting the CMOS Parameters

Before running the computer, certain parameters on the CMOS configurat
screens must be set so the computer properly operates.  First, set the
parameters on the CMOS Main Screen, then press the PgUp/PgDn key an
the parameters on the CMOS Extended Screen.

Note:
Some of the parameters are already set and should not be changed.  Only
change the settings if necessary.
4-3
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Setting the CMOS Main Screen

System Time and Date
To set the time, use the minus <-> key to decrease the number and the plus
<+> key to increase the number.  To move the prompt forward, use the rig
arrow <→> key; to move the prompt backward, use the left arrow <�←> key.
Follow the same procedure for the date.

Diskette Drive A or B
This allows you to configure a diskette drive added or removed from your
computer.  Use the <+/-> keys to toggle between the options.

Hard-Disk Drive 1-4 (IDE Drives Only)
This selection allows you to configure a hard disk installed in your system
Use the <+/-> keys to toggle between the options.  See Appendix C for a
complete listing of all possible hard drive types.

To install most SCSI hard drives, select NOT INSTALLED.  To manually
configure the hard drive, select USER CONFIG.  Press the down arrow <↓>
key and type in the appropriate parameters.  To automatically configure a
IDE hard drive, select AUTO CONFIG.  Drives that can be Auto-Configure
report parameters to the BIOS.

Base Memory and Extended Memory
Both of these memory settings are automatically configured.  Press the do
arrow <↓> key to move to the next selection.

Video Card
This sets the type of monitor required for your computer.  The display per
eral supports VGA/EGA, CGA80, CGA40, Monochrome (MONO), or no
monitor at all.  Use the <+/-> keys to toggle between the options.

System Speed
This parameter selects two speeds on the computer.  When set to NORM
the system operates at full speed.  When set to  SLOW, it runs at about ha
the normal speed.

Cache
This category allows you to enable both the internal and the external cach
enable the internal cache only, or disable both caches.  For optimal perfor
mance, select BOTH.
4-4
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External Cache Mode
This selection sets the secondary cache scheme.  Setting the scheme to
WRITE-BACK will improve performance up to 4%.

CPU Type
This option selects the CPU installed and has auto detection with corresp
ing jumper settings on board.  You must choose the correct CPU selectio
the corresponding CPU.  This selection is for user-upgradeable CPUs.

Setting the CMOS Extended Screen

You can toggle between the Main screen and the Extended screen (Figur
using the PgUp and PgDn key.

Figure 4-3  CMOS Extended Screen

System BIOS
The System BIOS Option allows you to Shadow, Shadow & Cache, or Di
the BIOS Shadow on the system board.  Choosing SHADOWED copies t
system’s BIOS into RAM for faster execution.  Choosing SHADOWED &
CACHED caches the shadowed system BIOS for even higher performan
This allows you to take advantage of the high-speed 32-bit bus and the 7
nanosecond RAM.  Use the <+/-> key to toggle between the options.
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Video BIOS
The Video BIOS Option allows you to Shadow, Shadow & Cache, or Disab
the BIOS Shadow on the system board.  Choosing SHADOWED copies th
system’s video BIOS into RAM for faster execution.  Choosing SHADOWE
& CACHED caches the shadowed video BIOS for even higher performance
Use the <+/-> key to toggle between the options.  The System BIOS Shado
option must be set to SHADOW or SHADOW & CACHE before enabling th
Video BIOS Shadow options.

On-Board Floppy
The On Board Floppy controller can be set to ENABLED or DISABLED.

Primary IDE
The VL-Bus IDE controller can be set to ENABLED or DISABLED.

Master Speed
The speed can be set for NORMAL, MEDIUM, or FAST.  To improve the
performance of your system, see the manufacturer’s specifications to deter
mine the optimal setting.  The default setting is NORMAL.

Slave Speed
The speed can be set for NORMAL, MEDIUM, or FAST.  To improve the
performance of your system, see the manufacturer’s specifications to deter
mine the optimal setting.  The default setting is NORMAL.

Secondary IDE
The ISA IDE controller can be set to ENABLED or DISABLED.

Serial Port 1
Serial Port 1 may be set for COM1 (default), COM3, or may be disabled.  B
sure this setting does not conflict with any other peripherals.

Serial Port 2
Serial Port 2 may be set for COM2 (default), COM4, or may be disabled.  B
sure this setting does not conflict with any other peripherals.

Parallel Port
The parallel port may be set for LPT1 (default), LPT2, or may be disabled. 
sure this setting does not conflict with any other peripherals.

Parallel Port Mode
The parallel port may be set for AT mode (output only), PS/2 mode (bidirec
tional), or may be disabled.
4-6
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Energy Saving Timer
The Energy Saving Timer conserves energy by putting the system into a “
mode.”  When the system is in sleep mode, it consumes less energy.

If a specified time elapses and no keystrokes are performed, the compute
into sleep mode.  The timer recognizes keyboard activity only (not mouse
movements).

This category can be set for one minute or in increments of fifteen minute
to 120 minutes).  After the allotted time, the CPU will reduce its speed to
8MHz.  The Energy Saving Timer must be set to DISABLED if a DX4-
100MHz is installed.  The Scroll Lock light will flash to indicate reduced
speed.  To return to full processing speed, press any key.

Non-Cacheable Area
This category allows a block of 32-bit memory to be set as NON-
CACHEABLE.  The size and address can be selected.  The sizes include:
128K, 256K, 512K, 1M, 2M, and 4M.

To select the memory to be Non-Cacheable, use the <+/-> keys to change the
first three zeros to the appropriate address (only these zeros can be chan
It must start from 0000000h to 0FF0000h (15.94MB).  The default setting 
this category is UNDEFINED.

Keyboard
If the keyboard category is set to INSTALLED, the computer will test the
keyboard during boot.  If set for NOT INSTALLED, the system will ignore
any keyboard errors and always attempt to boot.  Set this for INSTALLED
unless using the system board in an application which does not require a
keyboard.

System Password
When enabled, a password will be required to enter the system.

To set a system password, set this category to ENABLED.  After you have
finished configuring the BIOS, press the <Esc> key to exit followed by the
<F4> key to save the changes and reboot.  When the system reboots, it w
you to enter a new password.  After you enter the new password, the Sys
Password feature will be in effect.

Warning:
If you forget your password, it cannot be changed without discharging the
CMOS.
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Setup Password
When enabled, a password will be required to enter Setup.

To activate the Setup Password, set this category to ENABLED.  After you
have finished configuring the BIOS, press the <Esc> key to exit followed b
the <F4> key to save the changes and reboot.  After the system reboots, p
<Ctrl>, <Alt>, and <Esc> simultaneously to re-enter the setup program.  O
re-entering the Setup program, you will be asked to enter a new password
After you enter the new password, the Setup Password feature will be in
effect.

Re-Configuring Your Computer

Press the <Esc> key to reach the Exit Pop-Up Screen.  Now select <F4> t
save and initialize the new Setup.

Figure 4-4  Exit Pop-up Screen
Click here to continue
to the next chapter.....
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5 Installing Graphics
Accelerator Software
The LPM30 comes standard with the ATI mach64 video chip on board.
The mach64 chip is a 64-bit graphics accelerator offering superior vid
performance.  Certain utilities must be run before using the mach64.
For optimal performance, install the utilities completely.

Preparation

Make sure no hardware (internal modems, fax cards, or LAN cards)
using addresses between the range of 2E0 to 2EF, such as COM 4 
If they are occupied, change the device(s) to a different range outsid
2E0 through 2EF.

Make sure LAN cards, scanner cards, and other adapters are not us
memory addresses between C0000 and C7FFF.  Check and record
amount of memory installed on the system board.

Review the CONFIG.SYS file to determine if a Memory Manager
Device driver is loaded.  Memory Manager Device drivers (for exam
EMM386, QEMM, and 386MAX) may interfere with the mach64
installation.  Install the Memory Manager after the mach64 is com-
pletely loaded.
5 - 1
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Installation

Perform the following steps to install mach64 graphic utilities:

1. Turn on the monitor and then the computer.  (This allows mach64 to read
the monitor type from the monitor during power-up for proper card
operation).

2. From the DOS prompt, insert Disk 1 of the utilities into the appropriate
floppy drive.

3. From the drive where the utilities diskette is located, type INSTALL and
press <Enter>.

4. After the INSTALL program is initialized and loaded, the Main Menu
appears (see Figure 5-1).

Figure 5-1  Main Menu

Main Menu Options
System Information-Checks your system configuration and displays detailed
information, including boot-up files and any possible conflicts.  This informa
tion is based on your current system configuration and the card you are
installing.
5 - 2
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Installing Graphics Accelerator Software
Quick Setup-Sets the card to an optimal configuration using the information
acquired during system checking.

Drivers Installation-Installs enhanced graphics and multimedia drivers for
popular operating system checking.

Diagnostics-Tests the proper functioning of your card in both VGA and
accelerated display modes.

Advanced Setup-Should only be attempted by experienced computer users.
Although some settings may improve the performance of your card, they m
not be fully compatible with your system or specific software applications.

System Information
This program checks the system for possible conflicts and displays the car
configuration in the INFO BOX.  If a conflict exists, it issues a warning and
suggests possible corrective actions.  Perform the following steps to check
your system:

1. From the Main Menu, select SYSTEM INFORMATION by highlighting
the selection and pressing <Enter>.

2. Review the information in the INFO BOX and take any necessary actio
as directed.

Quick Setup
You must specify a monitor in QUICK SETUP.  Proper monitor selection is
necessary for correct resolution and refresh rate operation.  Information on
display modes supported by the highlighted monitor are displayed in the IN
BOX.  Perform the following steps to install the monitor type:

1. Select QUICK SETUP from the Main Menu by highlighting the selectio
and pressing <Enter>.  A Monitor Selection Menu will appear (see Figure
5-2).

2. Using the <↑/↓> keys, scroll the monitor list to highlight your monitor.  If
found, press <Enter> to select.  If your monitor is not listed, follow step
or b) described below:

a) If a VESA Display Information Format (VDIF) file is available
for your monitor, INSTALL can read it and get the necessary
parameters to set up the card for optimal monitor operation.  T
do so, insert the disk containing the VDIF file into your floppy
drive.  Select READ VDIF... from the Monitor Selection Menu.
5 - 3
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Change the DOS directory prompt to the drive containing the
disk.  INSTALL will read the file and configure mach64 to
support your monitor.

b)  Select CUSTOM... to set up the card to any supported monitor
specifications.  You will need to manually test and configure
each display mode separately.  To do so, select CUSTOM... an
press <Enter>.  Select a resolution and press <Enter>.  Pick a
refresh rate that matches the specification of your monitor and
press <Enter> to bring up the Adjustment Screen.  If the monito
does not display a proper Adjustment Screen at the lowest
refresh rate, set the resolution to Not Supported.

Warning:
Do not exceed the monitor specifications.  Using a refresh rate (i.e., vertica
frequency) that is higher than specified may damage your monitor.

A scrambled screen indicates your monitor is not capable of the selected
display mode.  In which case, immediately press <Esc> to exit.

Figure 5-2  Monitor Selection Menu

Drivers Installation
Selecting this option brings up the INSTALL ENHANCED DRIVERS menu
for installing ATI enhanced drivers.  See Chapter 6 for detailed instructions.

Utilities Installation
This procedure is for copying the utilities and the INSTALL program to your
hard drive.  The boot files can be modified automatically so you can run the
programs from any directory.  Perform the following steps to run the UTILI-
TIES INSTALLATION program:
5 - 4
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Installing Graphics Accelerator Software
Note:
It is recommended to accept the defaults suggested during installation.

1. Select UTILITIES INSTALLATION from the Main Menu by using your
arrow keys to highlight it and press <Enter>.

2. Enter the destination drive, directory, and press <Enter>.

3. Enter the source drive and press <Enter>.

4. Utilities are in the root directory of the Install Disk #1.  Accept the prom
for the root directory and press <Enter> to start copying.

5. When prompted for the boot drive, enter your boot drive (i.e., C) and
press <Enter>.

6. To run the INSTALL program from any directory (in DOS), you must a
the location of the utilities to the PATH statement in the
AUTOEXEC.BAT file.  The default directory name used by this installa
tion is C:\MACH64.

7. When finished, press <Esc> and exit from the Main Menu.

8. Changes made to the boot files (CONFIG.SYS and AUTOEXEC.BAT)
are active only if you reboot the computer.  If you encounter errors or
suspect the hard disk is full, refer to the Troubleshooting section in th
chapter or your DOS manual for information.

Diagnostics
From this menu, you can test the various operations and circuitry of the
mach64.  The diagnostics screen may be displayed at any supported resol
and color depth for testing.  These tests support mouse and keyboard ope
tions, and directions are displayed on the screen.  Errors found by testing
discussed in the Troubleshooting section of this chapter.

Advanced Setup
The number of options in the Set Power-Up Configuration menu (see Figu
5-3) depends on the card type (i.e., ISA, VLB, or PCI).  To set up these
options, use the arrow keys to highlight ADVANCED SETUP and press
<Enter>, then set the options to match your monitor and system type.  If y
need help, press <F1>.
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Warning:
The Advanced Configuration option allows you to use certain features may
add additional performance to your card; however, these options may not b
compatible with your system.  If problems occur after an advanced option is
changed, return the card to factory defaults to correct them.

Figure 5-3  Set Power-Up Configuration Menu

Advanced Setup Options
Monitor Type-Lets you specify a monitor type as you did in QUICK SETUP.

Power-Up Video Mode-This card can be configured to power up in VGA color
or VGA monochrome.

M Auto Select-This option automatically chooses a suitable mode for
your system.

M 16-bit-All coprocessor accesses are 16-bit wide.  Certain computer
systems may lock up when in this mode.  If this happens, select 8-bit
Host.

M 8-bit Host-Only data transfers between the host bus and graphics
memory are 8-bit; otherwise, coprocessor operations are 16-bit.  If
your computer has compatibility problems with this setting, select
8-bit.

M 8-bit Host-I/O operations are 8-bit.

The card can be reset to factory defaults by pressing <Shift><F7>.  Once yo
have finished configuring the necessary parameters described above, save
them to the card by pressing <F10>.  If you choose not to save the current
configuration changes, press <Esc> and choose Discard when prompted.  T
card then reverts to the previously saved settings in EPROM (or to factory
defaults if the card had never been configured).
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Installing Graphics Accelerator Software
Troubleshooting
Listed below are several checks you can make to help determine the cau
any problems:

System Lockup

M If you are using a memory manager such as QEMM or 386MAX, you
need to modify the command line in the CONFIG.SYS file so the
address of the graphics card video BIOS, C0000-C7FFF, is excluded
For example, add “X=C000-C7FF” to the command line.

M Remove all unnecessary boards.

M Disable shadow RAM.

M Ensure the board is seated correctly and the card has been installed
using proper utilities.

M Try the card in a different system and reset to factory defaults using
the INSTALL program.  If the card works in another system, the
problem is likely due to incorrect configuration.

Test Patterns OK; Applications Do Not Sync

M The wrong monitor type has been selected.  Change the settings in t
INSTALL program.

Window Driver Not Installing Properly

M Windows must be running in 386 Enhanced Mode.  Incompatible
commands or options within CONFIG.SYS may prevent Window
from starting in enhanced mode.  If this occurs, remove the offending
driver or reinstall the memory manager software.

AutoCAD Driver Not Installing Properly

M If using a 386, ensure AutoCAD has been configured for the
appropriate ADI driver.  The protected mode driver requires extende
memory.
5 - 7
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Table 5-1 lists problems and solutions for some common errors found by t
test program.

Problem Solution

EPROM BIOS
failure

Try reinstalling or run the diagnostics using
the /F switch.  This returns the card to
factory settings: M64DIAG /F <Enter >.

Memory aperture
test failure,
diagnostics program
locks, or reboots
during test (ISA
card only)

If you receive an error message indicating
the memory aperture location is conflicting
with your system memory, restart the
INSTALL program as follows: INSTALL
APMP <Enter >.  Now when you enable
Memory Aperture, you must select a
location above but not overlapping System
Memory (S), BIOS (B), or Reserved (R)
locations.  If the problem is due to address
limitations inherent with the ISA bus
architecture (i.e., aperture + system RAM
exceeds 16MB, disable aperture).

Desired resolution is
disabled and
displays in gray

A mode displayed in gray means the BIOS
is told this mode is not available, based on
the card configuration.  Reinstall using
custom monitor selection.

Menu item is
disabled and
displays in gray

The test program has determined the mode
or test is not available under current
configuration.  Aperture tests are not
available if the aperture is disabled.  CRT
mode and pixel depth are determined by
current installation, DAC type, and memory
size and type.

Table 5-1  Error Codes and Messages
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Problem Solution

Adapter not
detected

This message should only occur when a
mach64 ASIC is not detected.  If this
message occurs and a mach64 board is
present, it may indicate an I/O conflict exists
between Extended Memory Manager
(EMM) and Video ROM.  Try removing all
other boards from the system and booting
from a plain DOS disk.  Try excluding the
video BIOS address (C0000-C7FFF) from
the memory manager.  Refer to the
documentation furnished with the memory
manager software for information.

Any FIFO test error The effects of a bad command FIFO should
be visible (e.g., the screen does not come
up or it displays garbage.)

Quick memory test
error

Run Detailed RAM Test to confirm the error
and identify address of the error.

Detailed memory
test error

Run Detailed RAM Test several times to
confirm the error and take notes of any
messages and error codes.

DAC LUT test
failure

An error has occurred while testing the DAC
LookUp Table.  The problem should be
visible on the top color bar of any 8bpp
mode.

ROM checksum
error

An error has been detected in the ROM.

Draw sequence
failure

An error has occurred in the draw engine.  If
the error is intermittent, it might indicate a
marginal RAM failure.  The effects of this
failure may not be immediately apparent.

Table 5-1  Error Codes and Messages (Cont'd)

The information provided in this user guide enables you to solve most
problems.  For further assistance, please contact your vendor.
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The following error message may appear when the INSTALL program is
programming the EPROM:

Selected Memory Aperture Configuration May Conflict...

Ignore this message if the system has 12MB or more system memory and
Memory Aperture feature is disabled.  If the system CMOS configuration h
Video BIOS Shadowing enabled, reboot the system once the programmin
the EPROM has been completed.  If this message does not appear, conti
the installation procedure.
5 - 1 0
Click here to continue
to the next chapter.....
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6 Installing Video Drivers

A README file is provided for each application driver in the mach64
installation disks.  These files summarize the latest product revision
contain directions for installation, and use of enhanced drivers.  For
added convenience, you can load and print README files using any
word processor after their corresponding drivers have been installed

README files for AutoCAD and MicroStation drivers are automati-
cally displayed as you install the drivers. If you install the driver for
Microsoft Windows, a README icon will be installed and placed in a
program group called “mach64 DeskTop.”  Click on this icon for feature
and usage information about the driver.

Installation

Applications use video device drivers to display data on the screen. 
mach64 drivers give you more screen resolutions and color depths th
standard device drivers.  Furthermore, mach64 supports IBM standard
VGA and VESA drivers that normally come with most major software
packages.  To fully utilize the enhanced speed, resolution, color dep
and other features of this chip, you should use mach64 drivers.

Note:
To conserve hard disk space, install only the drivers you use.  You m
require application software disks during driver installation.

De-Installation

This installation program allows you to effortlessly de-install some
mach64 drivers and return your application or operating environment
VGA support.  This feature is available for Windows 3.1 and OS/2
Manager.  Details are given in the respective sections.
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Microsoft Windows 3.1

The mach64 driver for Windows delivers increased performance at high
resolutions and color depths.  You need to install this driver using the steps
outlined below.

The DRIVERS INSTALLATION option in the Main Menu sets FlexDesk+
and WinSwitch automatically.  FlexDesk+ customizes the operational/displa
settings of the driver.  WinSwitch adds the capability of switching screen
resolution and/or colors with a key.

De-Installation Procedure
Skip this section if you have not previously installed any mach64 window
driver.  The program removes all existing driver from your hard disk and
cleans up all associated Windows and MVA files.

Perform the following steps to de-install driver using Microsoft Windows 3.1

1. Record the location of the Windows application.

2. Run the mach64 installation program and SELECT DRIVERS INSTAL-
LATION from the Main Menu.

3. From the list of applications:

a) Select Microsoft Windows.
b) De-Install Windows 3.1 driver.
c) Follow screen instructions to completion.

Installation Procedure
Perform the following steps to install drivers using Microsoft Windows 3.1:

1. Ensure your card has been installed and configured as described in
Chapter 5 before continuing with this procedure.

2. Start Microsoft Windows to ensure it is properly installed, then quit
Windows.

3. Run the mach64 installation program and SELECT DRIVERS INSTAL-
LATION from the Main Menu.

4. From the list of applications:
6-2
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a) Select MICROSOFT WINDOWS.
b) Select INSTALL WINDOWS 3.1 DRIVER and note the messages.
c) Follow screen instructions to completion.

5. After copying is done, record the Windows setup instructions, then p
<Esc> to exit.

6. Exit the INSTALL program and restart Windows.

7. The ATI DeskTop icon is created automatically during driver installat
Select it to customize the look-and-feel of Windows.

AutoCAD 386 R10/R11/R12

Perform the following steps to install driver using AutoCAD 386:

1. Run AutoCAD 386 (protected mode) to ensure it is properly installed
your system.  Note the directory location of the AutoCADprogram file
before you start the mach64 installation program.  You will need this
information later.

2. Run the mach64 installation program and SELECT DRIVERS INSTAL
LATION from the Main Menu.

3. From the list of applications, select AutoCAD.  When asked for sour
drive and directory, type in the information and insert requested disk

4. Follow instructions on the screen to install the DLXpress driver.

5. When driver installation is completed, exit the installation program.  
ADIACAD.BAT to set the necessary driver parameters for the DOS
environment as follows:

ADIACAD  <Enter>

ADIACAD.BAT was created by the mach64 installation program for you
convenience.  The parameters it sets must be in the environment be
you start AutoCAD.

TIP: If you are using a batch file to start AutoCAD, consider
6-3
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adding ADIACAD to your batch file.

6. Start AutoCAD and reconfigure it to use the enhanced display list driv
For example, if you start AutoCAD using a batch file called
ACADR12.BAT, type:

ACADR1 -R <Enter>

The “-R” parameter is supported only by AutoCAD release.  For other
releases, refer to your AutoCAD manuals.

Documentation for the DLXpress driver is provided on the installation
diskette.  See the README.DLX file for details.

IBM OS/2 Presentation Manager 2.1

Installation Procedure
Perform the following steps to install driver using the IBM OS/2:

1. Start OS/2 2.1 to ensure it uses the Video Graphics Array (VGA) drive
before continuing with this procedure.

2. Insert the mach64 installation disk #1 into a floppy drive.

3. Open the DOS Full Screen icon.

The mach64 installation program does not run in a DOS window.  The
DOS Box must be Full Screen for successful operation.

Do not switch out of Full Screen to run Diagnostic Tests.  Doing so wil
result in a corrupted display.

4. Type: A:\INSTALL  <Enter> (For drive B, substitute B: for A: ).

5. Select DRIVERS INSTALLATION from the Main Menu.

6. This will copy the mach64 driver to the MACH_OS2 directory.

7. Open an OS/2 Window or OS/2 Full Screen icon and type:

DPINSTL <Enter>.
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8. When the Display Driver Install panel appears, select Primary Displa
choose OK to bring up the selection list.

9. Select ATI Technologies mach64 from the list and choose OK.

10. When the source directory panel appears, choose Change.  Select th
and directory where the mach64 driver resides (e.g., C:\MACH_OS2),
then choose Set and Install.

11. After the driver is installed, do a shut down, then restart OS/2.

12. The OS/2 driver will first come up as 640x480 in 256 colors.  Perform
following steps to change screen resolution and/or color depth:

a)  Open the “OS/2 System” icon.
b)  Open the “System Setup” icon.
c)  Open the “System” icon.
d)  Select the “Screen” tab in the “System-Settings” window.
e)  Select desired resolution and color depth from list.
f)  Close the “System-Settings” window.
g)  Do a shutdown of OS/2, then restart your computer.

Note:
The resolution you select for the OS/2 driver must be a supported and en
resolution as defined by the Monitor Type setting chosen in the mach64
installation program.

De-Installation Procedure
Perform the following steps to de-install driver using IBM OS/2:

1. Open an OS/2 Window or OS/2 Full Screen icon and type:

DPINSTL <Enter>

2. Select “Video Graphics Array (VGA)” as the Primary Display.  The
Source Directory panel appears.

3. Insert the OS/2 Display Driver disk in the floppy drive. Select the driv
and directory where the VGA driver resides (typically A: or B:), choos
Set, then choose Install.

4. After the driver is installed, do a shutdown of OS/2, then restart your
computer.
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Continue with the following steps if you wish to remove mach64 files from
your hard disk.

5. Open the DOS Full Screen icon.

6. Change to the mach64 directory and type:

INSTALL <Enter>

7. Select DRIVERS INSTALLATION from the Main Menu.

8. Select IBM OS/2 from the list of applications.

9. Select UN-INSTALL OS/2 Driver, then follow instructions on the scree

Intergraph MicroStation 4.0

Perform the following steps to install driver using Intergraph MicroStation.

1. Ensure MicroStation is properly installed on your system before contin
ing with this procedure.

2. Run the mach64 installation program and SELECT DRIVERS INSTAL-
LATION from the Main Menu.

3. From the list of applications, select MicroStation.  Enter the sourcedriv
and directory information, then insert the disk prompted.

4. Follow the instructions on screen to complete the driver installation.

5. When driver installation is completed, press <Esc> to exit.

6. Refer to the README.USD file that was copied to your MicroStation
directory for instructions and driver configuration details.
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Microsoft Windows NT

Installation Procedure
Perform the following steps to install driver using Microsoft Windows NT:

1. Run the Windows NT Setup program.  It is located in the Program
Manager Main window.

2. Insert the ATI installation disk marked Windows NT Driver into your
floppy drive.

3. Select Other and supply the Setup program with the location of the N
files (i.e., B:\NT if using drive B).  The program will install the ATI
driver.

4. Restart Windows NT.

Note:
If the NT driver resolution selected is not supported, the display reverts t
640x480 regardless of the resolution setting selected in the Presentation
Manager driver setup.

De-Installation Procedure
You may de-install the mach64 driver for Windows NT using either of the
following steps:

1. In the WINNT\SYSTEM32\DRIVERS directory, rename the ATI.SYS
file; for example, to ATI.ATI.  When you restart Windows NT, it will no
find ATI.SYS and boot up in VGA.

2. Run the Windows NT Setup program and select a non-ATI driver; fo
example, a VGA-Compatible driver.  When you restart Windows NT, 
boots up with the non-ATI driver you just selected.
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Microsoft Word (for DOS) 5.x and 6.0

Mach64 drivers for Microsoft Word support 640x480, 800x600, and
1024x768 screen resolutions in 16 colors.  Perform the following steps to
install driver using Microsoft Word:

1. Run Microsoft Word to ensure it is properly installed on your system
before continuing with this procedure.

2. Run the mach64 installation program and SELECT DRIVERS INSTAL-
LATION from the main menu.

3. From the list of applications, select Microsoft Word.

4. Select an appropriate Word program version.

5. Follow the instructions on screen to complete the driver installation.

6. When driver installation is completed, press <Esc> to exit.

7. Refer to the README file which was been copied into your Word
directory for instructions and driver configuration details.
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WordPerfect (for DOS) 5.x and 6.0

WordPerfect Versions 5.0 and 5.1
The mach64 drivers for WordPerfect 5.x support 800x600 and 1024x768
screen resolutions in 16 colors.  Perform the following steps to install dri
using WordPerfect Versions 5.0 and 5.1:

1. Run WordPerfect to ensure it is properly installed before continuing 
this procedure.

2. Run the mach64 installation program and SELECT DRIVERS INSTAL
LATION from the Main Menu.

3. From the list of applications, select WordPerfect.

4. When prompted, insert the disk and enter the source drive and direc
information of the disk.

5. When asked, enter the directory where WordPerfect is installed.  Pre
<Enter> to copy the necessary driver files to that directory.

6. When driver installation is completed, press <Esc> to exit.

7. Run the WordPerfect Setup program to select this enhanced driver, 
follows:

a) Run WordPerfect, press <Shift><F1> for the Setup option.
b) Press <D> for Display.
c) Press <G> for Graphics Screen Type.
d) Select the mach64 driver and press <Enter>.
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WordPerfect Version 6.0
This chip supports the VESA SVGA BIOS Extension which supports seve
high resolution display modes.  Perform the following steps to install drive
using WordPerfect Version 6.0:

1. The mach64 accelerator must be set up for the resolution intended to u

2. Run the WordPerfect Setup program to select a VESA display mode 
follows:

a) Run WordPerfect, press <Shift><F1> for the Setup option.
b) Press <D> for Display.
c) Press <G> for Graphics Screen Type.
d) Press <S> for Screen Type.
e) Select VESA VBE (VESA BIOS Extension) and press <S>.
f) Select one of the displayed modes and press <S>.  A Driver Warn

dialog may appear; if so, consult the WordPerfect documentation
information.

g) Press <Enter> as prompted.  When you exit the Setup program, 
should be in the selected mode.  If not, repeat Step1 to check if th
card is correctly configured for this resolution.
Click here to continue
to the next chapter.....
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7 Setting up the SoundDrive 16
Designed to be easy to use and easy to install, the SoundDrive 16 
controller can be used with preset jumper settings.  If you need to
change the default address settings, see Chapter 2.

Hardware Installation

1. If you previously installed another sound card, remove it and a
associated files from your SYSTEM.INI and CONFIG.SYS files

2. If you are connecting external speakers to the SoundDrive 16,
connect the speaker cable to the SPEAKER jack on the back o
system board (Figure 3-10).

3. If you are connecting amplified external speakers to the
SoundDrive 16, connect the speaker cable to the LINE OUT ja
on the back of the system board (Figure 3-10).

4. If you are connecting a microphone to the SoundDrive 16, con
the microphone cable to the MIC jack on the back of the system
board (Figure 3-10).

5. If you are connecting a MIDI device or a joystick to the
SoundDrive 16, connect the cable to the joystick port on the ba
the system board (Figure 3-10).

6. If you are installing a CD-ROM, you will need a CD-ROM audio
cable to play music CD’s on your system.  Contact your dealer 
obtain the correct cable.

Note:
If you are installing a CD-ROM drive, it is recommended you install
before setting up the SoundDrive 16 sound controller.  See Installing a
CD-ROM Drive at the end of this chapter.
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Software Installation

1. Start Microsoft Windows.

2. Insert the SoundDrive 16 software disk into your floppy drive.

3. From the Program Manager File menu, choose Run.

4. Type the drive letter, then SETUP.EXE; e.g., A:\SETUP.EXE.

5. The SETUP.EXE program automatically copies the SoundDrive 16
software and application programs to your hard drive.

6. Once the software is installed, the SETUP.EXE program automatically
updates your CONFIG.SYS and AUTOEXEC.BAT files.

7. At this point, you must exit Windows and reboot your system.  The CD
ROM drive is initialized on bootup.  If it does not initialize on bootup,
check for an I/O, DMA, or IRQ address conflict.  Verify the address
settings of other peripherals in your system to correct the address
conflict(s).

8. If you are installing a CD-ROM drive, refer to the installation procedure
provided by the CD-ROM manufacturer.

The SoundDrive 16 hardware and software installations are complete.  Th
application programs installed will be located in the Orchid Audio Applica-
tions group on the Windows desktop.
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External Devices

External Speakers
You can connect 4 or 8 ohm external speakers or headphones to the LP
The speakers and headphones plug into the SPEAKER jack on the bac
system board (Figure 3-10).

Joystick
Plug the joystick into the 15-pin game port connector (Figure 3-10).

MIDI
If you purchased the optional MIDI interface kit, you will have an additio
cable.  This cable plugs into the 15-pin connector and provides MIDI IN
MIDI OUT connections, in addition to a joystick connection. Connect thi
cable to the game port and connect any MIDI devices to the appropriate
cables.

Microphone
You can connect a 300-600 ohm microphone to the LPM30.  Plug it into
MIC jack on the back of the system board (Figure 3-10).

CD-ROM
The LPM30 supports IDE CD-ROM drives and has an MPC Level 2 aud
connector for CD audio.

Line In
You can connect an external mono or stereo audio source to the LPM30
as a tape player or radio.  Use the appropriate converter cable to interfa
your external equipment.

Line Out
Allows you to connect the output of the SoundDrive 16 audio controller 
your home stereo, VCR, or amplified speakers.

The MIDI Interface
An optional MIDI Kit is available for the LPM30.  The kit includes a Soun
Blaster-type MIDI cable and MIDI software.  To purchase the kit call you
local dealer or Micronics’ Sales department.  See the Technical Help an
Warranty Information card for Orchid telephone numbers.
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Installing a CD-ROM Drive

Micronics recommends the installation of an IDE CD-ROM.  If you are
installing a CD-ROM drive these instructions will help you, but you should
also refer to the documentation that came with your CD-ROM drive.  Before
starting the setup and installation, make sure that your computer is turned O
and the power cord has been disconnected from the wall outlet.  Your CD-
ROM drive kit should contain the following items for a successful installatio

m CD ROM Drive with optional slide rails.
m Interface Cable.
m Audio Cable.

Install the CD-ROM hardware as recommended by the CD-ROM manufac-
turer.  Follow the steps below for help on installing the CD-ROM audio cabl

Installing the cable:

1. Connect the ribbon cables as described in the CD-ROM’s documentati

2. Connect the audio cable to the CD-ROM drive's audio connector.

3. Connect the other end of the audio cable to the MPC-2 compatible CD
ROM audio connector on the LPM30 system board (Figure 3-10).

4. You are now ready to setup the SoundDrive 16 sound controller.  Follow
the “Hardware Installation” and “Software Installation” sections at the
beginning of this chapter.

CD-ROM Device Drivers
CD-ROM drives require device drivers to access the drive.  These device
drivers are generally provided by the manufacturer of the CD-ROM drive.
Usually one device driver is added to the CONFIG.SYS file and one to the
AUTOEXEC.BAT file.

The device driver added to the CONFIG.SYS file is the CD-ROM device
driver.  This file configures the CD-ROM drive and initializes the drive on
boot up.  It is dependent on the type of CD-ROM drive installed.  The devic
driver added to the AUTOEXEC.BAT file is an executable file, which tells th
operating system that a CD-ROM drive is installed in the system and what
configuration the CD-ROM drive is using.  MSCDEX.EXE is a commonly
used device driver.  There are other versions of this device driver which
perform the same function, such as the CORELCDX.COM device driver.
7-4

Click here to continue
to the next chapter.....



ities
are
lay

ltime-
tions
 to

rmi-
8 SoundDrive 16 Utilities

The On-board SoundDrive 16 comes with DOS and Windows util
which allow you to send commands to your CD-ROM drive, softw
volume control, and a mixer.   In addition, you have the ability to p
instrumental music through your computer keyboard.

Also included are audio applications to take advantage of the mu
dia capabilities of SoundDrive 16.  The utilities and audio applica
are automatically installed using the SETUP.EXE program.  Refer
Chapter 7 if you have not installed the SoundDrive 16 software.

Note:
This manual presumes you are already familiar with the basics of
Microsoft Windows.  Please refer to the Microsoft manual when te
nology or installation steps are unfamiliar.

Note 2:
You cannot run the CD-ROM utilities from the Windows MS-DOS
prompt.  You must first exit Windows.
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SCSI CD-ROM Utilities

The following SCSI CD-ROM utilities are DOS programs and must be run
from the DOS (C:\) prompt.

FDCDTEST
This utility will test the integrity of the CD-ROM device driver(s) and drive.

FDEJECT
Ejects the CD-ROM disc from the CD-ROM drive.  If the drive door is locke
this utility unlocks the door and then ejects the disc.  This function is valid
only for CD-ROM drives that support a software controlled eject command

FDLOCK
Locks the door on the CD-ROM drive.  On most drives, this disables the ej
button on the front of the drive.

FDUNLOCK
Unlocks the CD-ROM door that was locked by FDLOCK or another utility.

FDAUDIO
A Terminate-and-Stay Resident (TSR) utility is used as an audio CD playe
Once it is loaded into memory, FDAUDIO may be accessed from within a
program by pressing the SHIFT-ALT-CTRL keys simultaneously.  Press the
ALT-F4 key to terminate the TSR.

The following options are available for FDAUDIO:

<< Skip Back: skips back one track.

>> Skip Forward : skips forward one track.

< Fast Reverse: skips back 10 seconds into current track.

> Play: plays the current track if the CD is not currently playing.

>> Fast Forward: skips forward 10 seconds into the current track if
the CD is currently playing.

 " Pause/Resume: Pauses the current track if the CD is playing or
resumes if the CD is paused.

■ Stop: stops the CD.

▲ Next CD: goes to the next CD player if there is more than one C
in the system (for example, if the current CD is at drive letter D:,
then the next CD will be at E:).
8-2
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▼ Previous CD: goes to the previous CD player if there is more t
one CD in the system (for example, if the current CD is at driv
letter E:, then the previous CD would be D:).

Key-Z Player
Key-Z player allows you to play instrumental music from your computer,
using a standard computer keyboard.  The unique note mapping feature
prevents you from playing an incorrect note in your chosen Key or Scale
Your computer is transformed into an intelligent polyphony (multiple note
a time) musical instrument which is exhilarating to play.

Key-Z Player incorporates the following features: a standard MIDI file so
player, graphic piano keyboard display, graphic mixer with volume, chan
patch, pan and mute control, and over 40 song styles.

To run Key-Z Player
From the Orchid Audio Applications program group, double-click on the 
Z Player icon.  The following screen appears:

Figure 8-1  Key-Z Player Screen

The buttons at the top of the screen are from left to right: File, Key, Scale
Layout, Settings, Player, Piano, Mixer, and Help.  To access a feature, c
once on the feature.

Key - allows you to choose from 12 different keys.  Click on the key of yo
choice.  You can change the key any time by clicking on the Key button a
selecting another key.

Note:
After you have made your selection, a check mark appears next to your
selection.

Scale - Key-Z Player offers four types of scales: Major, Minor, Blues, and
Harmonic Minor.  Choose a Scale the same way you choose a Key Sign
8-3
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Click once on the preferred scale to start playing music from your compu
keyboard.

Layout - maps the notes on your keyboard to your choice of Jagged or
Horizontal.

Jagged - maps the keys so that they progress up the scale alternating
This mapping also works well for organ solos and arpeggios.

Horizontal - maps the keys so that they progress up the scale from le
right, from  the bottom to the top, while increasing the pitch for each r
This mapping works great for quick string-scale runs and playing blue
piano.

Setting - offers the following four features:

MIDI Mapper - allows you to view your current MIDI Mapper settings
from inside Key-Z Player.

Note:
 All notes from Key-Z Player are routed through the Mapper.  Refer to
Windows User’s Guide for instructions on setting up the MIDI Mapper

Multimedia Drivers - allows you to view your currently installed multim
dia drivers.

Note:
Your multimedia drivers must be installed for Key-Z Player to function

Patch Names - this feature gives you a list of eight types of sound
hardware:

0-127 1-128
General MIDI Proteus
MT-32 Roland GS
U-110 U-110 Tones

Keyboard - brings up a dialog box which allows you to adjust Channel
Patch and Volume changes.

Note: You may add to the Patch List by editing the PATCHES-INI file
located in your Key-Z Player directory.
8-4
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Player - opens or hides the Song Player window which includes the contr
for playing standard MIDI Song Files.  You can also measure the length o
song by using the Bar Control option.

Bar Control - the bar control detects the length of the song, (how man
measures the song consists of).  For example, if you have a 128 bar 
the bar control will start at Bar Zero, which is the beginning of the son
It will play through the entire song, ending at Bar 128.

Note:
The song must be stopped before using the bar control slider.

Piano - graphically displays all notes which are playing.  The graphic key
board has seven full octaves.

Mixer  - features 16 channels and allows you to control the Patch, Volume
and Mute of each track in the Song File.  Make sure the patch for each tr
set to an appropriate patch for your output device.

Key-Z Player - Solo
Key-Z Player can be used to perform solo compositions, test melodies, p
rhythm and bass tracks, and learn scales and arpeggios in various keys.

To play Key-Z Player - Solo:

1. Select the Key and Scale you desire.
2. Select the Patch for the sound you desire.
3. Select the keyboard mapping from the Layout menu.
4. Set your Volume and begin playing by tapping out notes on your com

puter keyboard.

Keyboard Notes
The playable key is shown in white.  You can play multiple notes and cho
by pressing several keys at once (this is called polyphony).

Figure 8-2  Playable Keyboard Note
8-5
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Note Progression
Notes begin with the lowest left row (the Z row) in Horizontal Mapping and
the “A” key in Jagged Mapping.  This ends with the highest note on the up
right.

Sustain
There are several ways to get sustained notes:

For continuous sustain, press the Caps Lock key.  The notes played are
sustained until the Caps Lock key is pressed again.

or

Hold down the Shift key while playing various notes.

Key-Z Player - Accompanied
Key-Z Player may perform melodies while being accompanied by any
standard MIDI Song File played in real-time.

To play Key-Z Player - Accompanied:

1. Open the Song Player window by clicking on the Player menu button.

2. Click on the Open Song button and select a song to play.

3. When the file is opened, it will use the default settings for Key, Scale, 
Tempo.  In addition, the track structure of the Song File (including the
instrument name and MIDI channel) is set into the Mixer.

Note:
Key-Z Player can read and play Format 0 and Format 1 MIDI files.  The
standard MIDI files included with Key-Z Player are Format 1 files and
contain the optional Key and Scale data.

Click here to continue
to the next chapter.....
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9 Audio Applications

Using Audio Recorder

The Audio Recorder can record, playback, compress and store voic
recordings, and music.  It allows you to add and edit voice annotati
within Microsoft Windows applications such as Word for Windows,
Microsoft Excel, Lotus 1-2-3, and all other application software whic
support Object Linking and Embedding (OLE).

It provides different settings and compression levels for recording a
output level controls.   It is compatible with Microsoft Windows Sou
Recorder for recording, editing, and playback.

The Audio Recorder can record and playback in .WAV format and
.AUD format.  The .WAV format is Microsoft Windows 3.1 format for
audio files.  The .AUD format uses ESPCM/ADPCM compression t
produce an audio file.

Different levels of compression are available in the Audio Recorder
Audio Recorder supports linear PCM compression, ADPCM compr
sion, and ESPCM compression at low, medium, and high levels.

To start Audio Recorder:

1. Start Microsoft Windows.

2. From the Orchid Audio Applications window, double-click on the
     Audio Recorder icon.  The following screen appears (Figure 9-1
9-1
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Figure 9-1  Audio Recorder Screen

The buttons at the bottom of the Audio Recorder window are from left to
right: Record, Play, and Stop.  The Audio Recorder can receive input from
microphones, a cassette tape player, a compact disk player, or any other 
source.  The large area in the center of the window shows the waveform o
current audio file.

Recording an Audio File

To record a new file:

1. From the File menu, click on New.  The following screen appears:

Figure 9-2  Sound Attributes Screen

2. Select your sampling rate, select stereo if desired (default mono), and
choose the compression format.  For the highest sound quality or to e
or modify the recording with the Effects command before saving, sele
one of the PCM (uncompressed) formats.  Choose one of the ESPCM
ADPCM compression formats if you wish to save disk space and do n
mind sacrificing some sound quality.
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3. Click on the Record button.

4. Speak into the microphone.

5. When you are done, click on the Stop button.

6. From the File menu, click on Save As.  If the file is uncompressed a
you wish to save it uncompressed, choose a directory location, ente
name for the audio file, then click on OK button to save it.  The
uncompressed audio file is saved as a .WAV file.

If the file is uncompressed and you wish to compress it, click on the
Options button and select the compression format you want.  Click o
OK button.  The  compressed audio file is saved as a .AUD file.

You can use the Recording Control window to regulate the mix of audio
several sources.  See the Recording Control section for more informatio

Playing an Audio File

To play a file:

1. From the File menu, click on Open.  The following screen appears:

Figure 9-3  Playing a File Display

2. Load an audio file into the Audio Recorder.

3. Click on the Audio Recorder Play button to hear the audio file.  The
will play to the end unless interrupted by pressing the Stop button.

While a file is playing, the wave box graphically displays the wavefo
of the audio file as if shown on an oscilloscope.
9-3
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Changing the Waveform

The Audio Recorder’s waveform display provides a graphic representatio
the audio file currently in memory.  You can control the display with the
vertical and horizontal scroll bars.

m To zoom in on (or magnify) the waveform, move the vertical scroll but
down.  To zoom out, move the vertical scroll button up.

m To see more of the waveform ahead or behind the part currently displ
click the right or left area of the horizontal scroll bar.

m To mark a portion of the audio file for playback, use the mouse to sele
the section in the waveform display.  Then choose Play to hear the
selected section.

m To deselect a selected portion of the waveform, click anywhere in the
waveform display.

m To select the entire file, double-click anywhere in the waveform displa

Adding the Volume Control and Mixer

You can regulate the playback sound level or stereo balance with the Volu
Control.  See the Volume Control section for more information.

You can use the Mixer option to play the current audio file together with o
sound sources.  See the Mixer section for more information.

Adding Sound

The Audio Recorder’s drag and drop feature enables you to embed audio
in documents.

1. Load your Windows application and open a document.

2. Load an audio file.

3. Move the cursor to the icon at the top right of the Audio Recorder.  T
cursor changes into a hand.  Press the mouse button down and dra
icon to the document window.  Release the button at the place you w
the audio icon to appear.
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4. To play the audio in your document, double-click on the icon.

You can add audio to a document from the document’s application.  P
the cursor where you want the audio icon to appear, choose the
application’s command for inserting an object, then select Audio Reco
in the list box.

Edit Menu Commands

Insert File
Inserts another audio file into the current audio file at the current play
position.  Inserting a file increases the length of the current audio file.
The maximum length of a file is determined by the amount of memory
available.  You can also insert audio from the Clipboard.

Mix File
Mixes another audio file with the current audio file at the beginning or
the end.  The audio files will blend together and play simultaneously.
Mixing a file may increase the length of the current audio file.  The
maximum length of the new audio file is determined by the amount of
memory available.  You can also mix with audio from the Clipboard.

Delete File
Deletes the selected portion of the audio file.  If you wish to save the
deleted section, use the Cut command instead of Delete.  To restore a
deleted audio section, choose the Undo command before making any
other changes to the file.

Changing the Properties
An audio file contains more than sound.  You can attach a title, descriptio
and an icon to the audio file.

To change the properties of a file:

1. From the File menu, click on Properties.  The following screen appea
9-5
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Figure 9-4  Changing the Properties

From this screen, you can place the cursor in the Label or Description
to add or change the label or description for the audio file.

2. Click the Play button to hear the audio file.

3. The Audio Recorder assigns a default picture of a microphone to eac
audio file.  To select another picture more representative of the audio
file’s contents, click on the Set Picture button.

4. From the Set Picture screen, select the picture to appear with the aud
file.  Any graphic can be saved in a bitmap (.BMP or .DIB), wave
(.WAV), icon (.ICO), executable (.EXE), or library (.DLL) file. The
picture selected will appear in the Audio Recorder.  It will also appear
any document in which you embed the audio file.

5. When you are finished, click on the OK button.
9-6
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The Recording Control

An audio file contains more than sound.  You can attach a title, description
and an icon to the audio file.

Starting the Recording Control:

From the Orchid Audio Applications program group, double-click on the
Recording Control icon.  The following screen appears:

Figure 9-5  Recording Control Screen

The Recording Control can receive input from a microphone, compact dis
player, synthesizer, or any other Line-In source.  The Recording Control
displays the recording level and stereo balance controls for each of your
computer’s hardware sources.

1. To include a recording source, click on the check box in front of its na

2. To adjust the stereo balance of any source, drag its top horizontal slid
bar left or right.

3. To adjust the recording level of a source, drag its vertical sliding bar u
down.

4. To monitor a recording in progress, click on the Record Monitor check
box.
9-7
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The Volume Control

Starting the Volume Control:

1. From the Orchid Audio Applications program group, double-click on 
Audio Recorder icon or the Mixer icon.  From the Options menu, sele
Volume Control and the following screen appears:

Figure 9-6  Volume Control Screen

The Volume Control enables you to regulate the volume and stereo
balance at which sound is played.  You can use the Volume Control w
the Audio Recorder during playback.  If you are playing multiple sour
you can use the Mixer to combine them, and use the Volume Control
the master regulator.  The Volume Control receives input from a micr
phone, cassette tape player, compact disk player, or any other Line-I
source.

2. To adjust the stereo balance, drag the horizontal sliding bar left or rig

3. To adjust the volume, drag the vertical sliding bar up or down.

4. To turn the sound off, click on the Mute button.  The word MUTE
appears.

5. To turn the sound back on, click on the Mute button again.
9-8
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The Mixer

Starting the Mixer:

From the Orchid Audio Applications program group, double-click on the
Mixer icon.  From the Audio Recorder or Volume Control Window, open th
Options menu and select Mixer.  The following screen appears:

Figure 9-7  Mixer Screen

The Mixer allows you to combine signals from several audio sources duri
playback, with control over the volume and stereo balance of each source
When you use the Audio Recorder to play an audio file, you can open the
Mixer to combine audio from the file with audio from other sources.

The Volume Control acts as a master regulator of the combined signal fro
Mixer.  The Mixer can receive input from a waveform audio file, a micro-
phone, a compact disk player, a synthesizer or other Line-In source.

1. To adjust the stereo balance of a source, drag its top sliding bar left o
right.  To adjust the volume of a source, drag its vertical sliding bar up
down.

2. To turn off audio from any source, click on the  Mute button.  The wor
MUTE appears.  Click the Mute button again to turn the audio back o

3. To display the Volume Control window with the Mixer window, choose
Volume Control from the Options menu.
9-9
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The Extended Recorder

The Extended Recorder can be used to record meetings and for dictation.
the Audio Recorder, the Extended Recorder records, compresses, stores, 
plays music and other sounds.  Unlike the Audio Recorder, the Extended
Recorder compresses and stores the audio file directly to your hard disk u
ESPCM compression.  The recording time is limited only by the amount of
hard disk space you have available.

The Extended Recorder can record to and play back from both PCM and
.AUD formats.  PCM is the Microsoft Windows 3.1 audio file format.  The
.AUD format uses ESPCM compression to produce an audio file.  The
Extended Recorder provides a choice of linear PCM (8-bits or 16 bits) and
ESPCM low (4-bits) compression.

System Requirements

Use the Extended Recorder with a hard disk compression utility only if you
have a high-performance system and are using a low data rate for recordin
and playback.  Otherwise, your computer's CPU may become overloaded.

For Best Results
If you wish to use 16-bit stereo at 44KHz for recording or playback, your
system must follow the specifications below:

m 486 system running at 50MHz or faster

m 8 megabytes of RAM or more

m a hard disk access time of 15 milliseconds or faster

Operating a system without these specifications may cause data loss whe
attempt 16-bit stereo, 44KHz  recording.

Starting the Extended Recorder:

1. From the Orchid Audio Applications program group, double-click on th
Extended Recorder icon.  The following screen appears:
9-10
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Figure 9-8  Extended Recorder Window

The buttons at the bottom of the Extended Recorder window are from 
to right: Record, Play and Stop.  This window shows the current file’s
name, the current location in seconds, and the total length in seconds

2. You can display more information on the selected file from the Extend
Recorder.  From the Options menu, select Expanded View.  The follow
screen appears:

Figure 9-9  extended Recorder Expanded View

The expanded view enlarges the Extender Recorder window to show t
length of the recording, sample rate, mono or stereo, bits per sample and
the free disk space, and recording time available.

The Audio Clip Library

The Audio Clip Library includes music, phrases, and sounds.  You can pla
any audio file in the library by using the Audio Recorder (opened automati
cally by the Audio Clip Library), the Microsoft Sound Recorder, or other
recorders compatible with the Windows .WAV format.  You can also add
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folders and audio files of your own to the Audio Clip Library.

Starting the Audio Clip Library:

From the Orchid Audio Applications program group, double-click on the
Audio Clip Library icon and the following screen appears:

Figure 9-10  Audio Clip Library Window

The Audio Clip Library includes three folders titled Music, Phrases, and
Sounds.  The Music folder contains short musical interludes.  The Phrase
folder contains phrases used in business settings.  The Sound folder con
variety of mechanical and animal sound clips.

Talking Calculator

The Talking Calculator is an audio/visual calculator which allows you 
perform calculations in Windows 3.1.  You can reduce Talking Calcula
to an icon so it is readily available whenever you want to perform calc
tions.

To start Talking Calculator:

From the Orchid Audio Applications window, double-click on the Talking
Calculator icon.  The following screen appears:
9-12
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Figure 9-11  Talking Calculator Screen

To perform calculations with your mouse, just point and click.  You will he
the number or operation clicked and the resulting answer.  You can also u
the keyboard by pressing the corresponding keys for each Calculator but
The following table describes each key on the calculator, its keyboard equ
lent, and its function.

Button Key Function

+ + Addition
- - Subtraction
* * Multiplication
/ / Division
sqrt @ Square root of the displayed value
% % Calculates percentages
= = or ENTER performs any operation on the

previous numbers
+/ F9 Changes the sign of the displayed number
1/x r Calculates the reciprocal of the displayed

number
Back Backspace Deletes the rightmost digit of the displayed

number
AC ESC Clears the current calculation
CE DEL Clears the displayed number
MC CTRL+L Clears any value stored in memory
MR CTRL+R Recalls the value stored in memory
M- CTRL+M Stores the displayed value in memory
M+ CTRL+P Adds the displayed value to any value alread

in memory
NUM Directs to announce results as whole number
DIG Directs to announce results as digit
ANS Directs to announce answer only
MUT Directs to not make any announcements
9-13
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To access Help, click on Contents from the Help menu in the Talking Calc
tor window.

The Chime

The Chime announces the time musically.  Chime can announce the time
play audio files at different intervals when enabled.

To start Chime:

From the Orchid Audio Applications window, double-click on the Chime ic
The following screen appears:

Figure 3-12  Chime Screen

Chime continues to make announcements when you reduce it to an icon.
Chime parameters can be set by selecting the Settings menu.  To access
click on Contents from the Help menu in the Chime window.

The Timer

The Timer helps you to record time.  Whenever you stop the Timer, it an-
nounces the amount of time remaining.  It continues to display and annou
count time remaining when you reduce it to an icon.

To start Timer:

From the Orchid Audio Applications window, double-click on the Timer ico
(Figure 9-13).
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Figure 9-13  Timer

The Timer window can appear in analog or digital display.  Click on the S
button from the Timer window to begin the countdown.  If there is zero t
on the timer, click on the Reset button.  This will reset the timer to the
previous countdown.  To stop the Timer at any time, click on Stop (the s
button switches to stop when the timer is in operation).  To access Help,
on Contents from the Help menu in the Timer window.

The Audio Reminder

The Audio Reminder features two alarms with different time, sound and
snooze setups.  These reminders are set up as alarms which will play th
selected audio files at selected times.

To start Auto Reminder:

From the Orchid Audio Applications window, double-click on the Audio
Reminder icon.  The following screen appears:

9-14  Audio Reminder Screen

When the Audio Reminder is reduced to an icon, it will continue to opera
display, and set off the alarms as required.  To access Help, click on Co
from the Help menu in the Audio Reminder window.
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The Talking Clock

The Talking Clock helps you keep track of time.  It announces the time wh
you select the Say command.  You can display the Talking Clock as an an
or digital clock.

To start Talking Clock:

From the Orchid Audio Applications window, double-click on the Talking
Clock icon.  The following screen appears:

Figure 9-15  Talking Clock Screen

When you start the Talking Clock for the first time, a window with a standa
analog clock appears and displays the system time.  The next time you sta
Talking Clock, the last display mode used will appear.

You can change the size of the Clock window and move it wherever you w
so the current time, including seconds and date, appear on the screen.  W
the Talking Clock is set to "Always Minimize," it will continue to display and
announce the time when you reduce it to an icon.  To access Help, click o
Contents from the Help menu in the Talking Clock window.

Stopwatch

The Stopwatch allows you to measure duration of time.  You can set th
Stopwatch to sound a tick each second and announce the amount of t
elapsed from the time it was activated.  When you start the Stopwatch
the first time, it displays in analog display mode.

To start Stopwatch:

From the Orchid Audio Applications window, double-click on the Stopwatc
icon.  The following screen (Figure 9-15) appears:
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Figure 9-16  Stopwatch Screen

Digital display mode allows you to change the font.  From the Settings m
click on Set Font and select a font.  You can change the size of the Stopw
window and move it wherever you wish so the time lapsed, including min
and seconds, appears on the screen.  Stopwatch continues to display an
time when you reduce it to an icon.  To access Help, click on Contents fro
the Help menu in the Stopwatch window.
Click here to continue
to the next chapter.....
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SoundDrive 16
Troubleshooting

Troubleshooting

The following information will help diagnose problems you may hav
with the SoundDrive 16.  Following these simple steps serves a two
purpose:

You may be able to fix your problem and avoid having to contact the
Micronics Technical Support Department . . .

 or

if these steps do not help you solve your problem, they will most
certainly give you a better handle on what to tell technical support o
you do contact them.

The information provided here is in symptom/response form. That is
symptom is given, and a check point response is provided for you.

10
10-1



Micronics LPM30 System Board Manual

O

aker

apter

for
nd

uch
re

 in
Symptom 1

System locks up on bootup with the SoundDrive 16 installed.

Check

Check whether another peripheral in your system is using the same I/
address configured by Jumper W3 (Chapter 2) on the SoundDrive 16.

Symptom 2

No sound output.

Check

1. Is the external speaker properly connected to the SoundDrive 16 Spe
jack?

2. Is there another adapter in your system which may be using the same
address (I/O Address, DMA Channel, or Interrupt)?  If so, change its
addressing or select another address for SoundDrive 16. (Refer to Ch
2 for available addresses).

Symptom 3

Certain applications do not play sound.

Check

1. Verify the SoundDrive 16 and the software application are configured 
the same sound emulation modes (for example, Sound Blaster or Sou
Blaster Pro for digitized sound).

2. Many software applications require a large amount of base memory, s
as 640KB and are unable to operate if any drivers or TSR programs a
installed.  Try removing all unnecessary drivers and TSRs or load them
high memory (refer to your DOS user’s manual for more information).

3. Verify the SET BLASTER statement is in the AUTOEXEC.BAT file.
10-2
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4. Make sure the application is configured for the same IRQ, I/O, or DMA
as the SoundDrive 16.

Symptom 4

Certain applications do not play digitized sound, such as speech or sound
effects.

Check

1. Check for a conflict with the Sound Blaster interface configuration
settings.  Digitized sounds are played back through this interface.

2. Verify the SET BLASTER statement is in the AUTOEXEC.BAT file.
Some applications look specifically for this statement to set the Sound
Blaster environment.  Verify that the settings of the statement match th
configuration for the SoundDrive 16 and the software application.

3. Verify there is sufficient base memory to run the software application. 
you are configuring the software application for Sound Blaster, the
software application may omit digitized sound if there is not enough b
memory available.

Symptom 5

My joystick does not work when connected to the SoundDrive 16.

Check

Verify the Joystick Port in the SD16.EXE program is enabled.

Symptom 6

My microphone recording level is too soft or unable to record properly.

Check

1. Verify your microphone has the proper impedance or is too sensitive.  
SoundDrive 16 expects a microphone with an impedance of approxi-
mately 600-10K ohms.
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2. Verify the software used to record, and the Windows temporary directo
are not on a drive that is using a disk doubling utility.

3. Turn up the microphone input level.

4. Make sure the microphone is selected as the recording source.

Symptom 7

Wave files do not play correctly in Windows.

Check

1. Verify the settings for the SoundDrive 16 driver in Windows match the
hardware settings.  This can be done by opening the Driver icon from
Control Panel and double-clicking on the driver.

2. If the .WAV file keeps repeating, this indicates an IRQ conflict.

Symptom 8

I received the error message "Could not load audio driver" or "Gen-
eral Protection Fault."

Check

1. Is the SoundDrive 16 audio driver installed in Windows?  If no, install 
driver.  If yes, reinstall the driver.  From the Control Panel window, clic
on the Drivers icon, click on Add, and reload the "SoundDrive 16 WAV
& MIDI" driver.  Restart Windows and check the sound again.

2. Did you change the default address settings?  If so, you need to reset
address settings in Windows.
10-4
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Symptom 9

I received the error message "Disk Could Not Keep Up with Digital
Audio Rate."

Check

1. Were you recording when you received this error message?  Decrease
sample rate or bit resolution.  If you were recording in stereo, switch to
mono.

2. Are you using a disk doubling utility?  When you record, you are recor
ing directly to the hard drive.  Disk compression utilities can affect the
performance of the hard drive.

3. Have you defragmented your hard drive lately? Your software
applicaton may have encountered a performance problem with your h
drive.  Use one of the commercial disk optimizing utilities available.
Excellent digital audio performance requires you optimize your hard d
often.
Click here to continue
to the next chapter.....
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POST Messages
The following table lists the Power On Self Test (POST) messages,
possible causes, and solutions.

Message Possible Cause Solution
NO DISKETTE
CONTROLLER

Disk controller not
found.

Change the
Configuration.

DISKETTE DRIVE
RESET FAILED

Disk adapter has failed
or is improperly
configured.

Check the disk adapter.

DISKETTE DRIVE A
FAILURE

Drive A failed or is
missing.

Check the A drive.

DISKETTE DRIVE B
FAILURE

Drive B failed or is
missing.

Check the B drive.

DISKETTE READ
FAILURE; STRIKE
F1 TO RETRY
BOOT

Disk is not formatted or
is defective.

Replace the diskette with
a formatted diskette and
retry.

DISPLAY ADAPTER
FAILED USING
ALTERNATE

The color/monochrome
switch is not set
correctly, or the primary
video adapter failed.

Change the switch to the
correct setting, or check
the primary video
adapter.

ERRORS FOUND;
DISK X FAILED
INITIALIZATION

Hard disk configuration
information is incorrect.

Rerun SETUP and enter
the correct hard disk
information.

ERRORS FOUND;
INCORRECT
CONFIGURATION
INFORMATION;
MEMORY SIZE
MISCOMPARE

The size of the base or
the expansion memory,
does not agree with
configuration
information.

Enter correct memory
size and rerun SETUP
procedure.

A
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Message Possible Cause Solution

FIXED DISK
CONFIGURATION
FAILURE

The specified
configuration is not
supported.

Correct the hard disk
configuration.

FIXED DISK
CONTROLLER
FAILURE

The controller card has
failed.

Replace controller card.

FIXED DISK X
FAILURE (where X
=0 or 1)

The hard disk crashed. Press F1 to reboot or
rerun SETUP. If this does
not work, replace hard
disk.

HARD READ
FAILURE- STRIKE
F1 TO RETRY
BOOT

The hard disk failed. Press F1 to reboot or
rerun Setup. If this does
not work, replace hard
disk.

FDD CONTROLLER
FAILURE

Diskette controller failed. Replace controller card.

FDD A IS NOT
INSTALLED

Cannot find diskette
controller for drive A.

Install or replace
controller card.

FDD B IS NOT
INSTALLED

Cannot find diskette
controller for drive B.

Install or replace
controller card.

KEYBOARD CLOCK
LINE FAILURE or
KEYBOARD DATA
LINE FAILURE

Keyboard logic failed. Make sure the keyboard
cable is connected
correctly.

KEYBOARD STUCK
KEY FAILURE

A key is jammed or was
held down during boot.

Make sure the keys are
not jammed or dirty.

REAL TIME CLOCK
FAILURE

The real-time clock logic
failed.

Check battery and
replace, if necessary

TIME-OF-DAY NOT
SET- RUN SETUP
PROGRAM

The real-time clock time-
of-day is not running.

Run SETUP utility.

BIOS XXXX ROM
BAD CHECKSUM
(where
XXXX=C8000 to
E0000)

The optional ROM
checksum is bad.

Replace add-on card.
-2
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Message Possible Cause Solution

DISKETTE READ
FAILURE, or NOT A
BOOT DISKETTE, or
NO BOOT DEVICE
AVAILABLE

Hard/floppy disk failed or
is not bootable.

Replace the diskette with
a bootable diskette and
retry.

DECREASING
AVAILABLE
MEMORY, or
MEMORY FAILURE
AT AAAAAAAA
READ XXXX
EXPECTING YYYY
(where AAAAAAAA
= failing address,
XXXX=data read,
and YYYY=data
written)

The memory data
integrity failed.

Check contact points
between memory
modules and system
board.  Replace memory
modules if necessary.
Click here to continue
to the next chapter.....
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Beep and POST Codes

Beep codes are a series of beeps sent through the speaker which in
a problem during the Power On Self Test (POST).  If text appears on
video screen, the LPM30 has completed POST; any other tone from
speaker indicates something other than a POST error.  These tonesare
not described in Table B-1.

The beep error codes are a series of beeps.  The duration of the bee
tones are constant, but the length of the pauses between the beeps
For example: a 1-3-3 beep code will sound like one beep, a pause; t
beeps consecutively, another pause; and then three more beeps.

One beep code is often misunderstood.  If a video card is not installe
is failing, the system board will generate a long-short-long-short bee
code.  This is often interpreted as a 1-2-1 beep code.  But POST err
always vary in the length of the pause and not the duration of the be
tone.

Another way of identifying a POST error is to use a device called a
POST card.  This peripheral card is inserted into one of the ISA slots
and has an LED (or LCD) read out showing the contents of port 80h

The following table provides a list of all beep codes and POST rou-
tines..
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Code Beeps POST Routine Description
02 Verify Real Mode.
04 Get CPU type.
06 Initialize system hardware.
08 Initialize chipset registers with initial POST values.
09 Get in POST Reg.
0A Initialize CPU registers.
0C Initialize cache initial POST values.
OE Initialize I/O.
OF Initialize the localbus IDE.
10 Initialize Power Management.
11 Load alternate registers with initial POST values.
12 Jump to UserPatch0.
14 Initialize keyboard controller.
16 2-2-3 BIOS ROM checksum.
18 8254 timer initialization.
1A 8237 DMA controller initialization.
1C Reset Programmable Interrupt Controller.
20 3-1-1 Test DRAM refresh.
22 3-1-3 Test 8742 Keyboard Controller.
24 Set ES segment register to 4 GB.
28 Autosize DRAM.
2A Clear 512K base RAM.
2C 3-4-1 Test 512K base address lines.
2E 3-4-3 Test 512K base memory.
32 Test CPU bus-clock frequency.
34 Test CMOS RAM.
35 Initialize alternate chipset registers.
37 Reinitialize the chipset (MB only).
38 Shadow system BIOS ROM.
39 Reinitialize the cache (MB only).
3A Autosize cache.
3C Configure advanced chipset registers.
3D Load alternate registers with CMOS values.
40 Set initial CPU speed.
42 Initialize interrupt vectors.
44 Initialize BIOS interrupts.
46 2-1-2-3 Check ROM copyright notice.
47 Initialize manager for PCI Option ROMs.
48 Check video configuration against CMOS.
49 Initialize PCI bus and devices.
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Beep Codes
Code Beeps POST Routine Description
4A Initialize all video adapters in system.
4C Shadow video BIOS ROM.
4E Display copyright notice.
50 Display CPU type and speed.
51 Initialize EISA board.
52 Test keyboard.
54 Set key click if enabled.
56 Enable keyboard.
58 2-2-3-1 Test for unexpected interrupts.
5A Display prompt “Press F2 to enter SETUP”.
5C Test RAM between 512 and 640k.
60 Test extended memory.
62 Test extended memory address lines.
64 Jump to UserPatch1.
66 Configure advanced cache registers.
68 Enable external and CPU caches.
6A Display external cache size.
6C Display shadow message.
6E Display non-disposable segments.
70 Display error messages.
72 Check for configuration errors.
74 Test real-time clock.
76 Check for keyboard errors.
7C Set up hardware interrupt vectors.
7E Test coprocessor if present.
80 Disable onboard I/O ports.
82 Detect and install external RS232 ports.
84 Detect and install external parallel ports.
86 Re-initialize on-board I/O ports.
88 Initialize BIOSData Area.
8A Initialize Extended BIOS Data Area.
8C Initialize floppy controller.
90 Initialize hard-disk controller.
91 Initialize localbus hard-disk controller.
92 Jump to UserPatch2.
93 Build MPTABLE for multi-processor boards.
94 Disable A20 address line.
96 Clear huge ES segment register.
98 Search for option ROMs.
9A Shadow option ROMs.
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Code Beeps POST Routine Description
9C Set up Power Management.
9E Enable hardware interrupts.
A0 Set time of day.
A2 Check key lock.
A4 Initialize typematic rate.
A8 Erase F2 prompt.
AA Scan for F2 keystroke.
AC Enter SETUP.
AE Clear in-POST flag.
B0 Check for errors.
B2 POST done - prepare to boot operating system.
B4 One beep.
B6 Check password (optional).
B8 Clear global descriptor table.
BC Clear parity checkers.
BE Clear screen (optional).
BF Check virus and backup reminders.
C0 Try to boot with INT 19.
D0 Interrupt handler error.
D2 Unknown interrupt error.
D4 Pending Interrupt.
D6 Initialize option ROM error.
D8 Shutdown error.
DA Extended Block Move.
DC Shutdown 10 error.

The following are for boot block in Flash ROM:
E2 Initialize the chipset.
E3 Initialize refresh counter.
E4 Check for Forced Flash.
E5 Check HW status of ROM.
E6 BIOS ROM is OK.
E7 Do a complete RAM test.
E8 Do OEM initialization.
E9 Initialize interrupt controller.
EA Read in the bootstrap code.
EB Initialize all vectors.
EC Boot the Flash program.
ED Initialize the boot device.
EE Boot code was read OK.
-4
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CHard Disk Drive Types

The following table lists the hard disk types supported by LPM30.

Type Cyl Hd Pre Sec Size

1 306 4 128 17 10

2 615 4 300 17 21

3 615 6 300 17 30

4 940 8 512 17 62

5 940 6 512 17 46

6 615 4 -1 17 20

7 462 8 256 17 30

8 733 5 -1 17 30

9 900 15 -1 17 112

10 820 3 -1 17 20

11 855 5 -1 17 35

12 855 7 -1 17 49

13 306 8 128 17 20

14 733 7 -1 17 42

15 N/A N/A N/A N/A N/A

16 612 4 0 17 20

17 977 5 300 17 40

18 977 7 -1 17 56

19 1024 7 512 17 59

20 733 5 300 17 30

21 733 7 300 17 42
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Type Cyl Hd Pre Sec Size

22 733 5 300 17 30

23 762 8 -1 17 116

24 830 10 -1 39 68

25 1024 9 -1 17 76

26 918 7 -1 17 53

27 1024 8 -1 17 68

28 903 8 -1 46 162

29 1024 4 -1 17 34

30 820 6 -1 17 40

31 969 9 -1 34 144

32 615 8 -1 17 40

33 1024 5 -1 17 42

34 940 16 -1 26 190

35 1010 12 -1 55 325

36 903 4 -1 46 81

37 901 5 -1 53 116

38 980 5 128 17 40

39 966 16 -1 17 128

40 723 13 -1 51 234

41 1024 16 -1 63 504

42 966 5 -1 34 80

43 965 10 -1 17 80

44 776 8 -1 33 100

45 654 16 -1 63 321

46 683 16 -1 30 202

47 755 16 -1 17 100

User Config

Auto Config
Click here to continue
to the next chapter.....
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Processor Options Intel 486SX, 25 or 33MHz.
Intel 486SX2, 50MHz.
Intel 486DX, 33MHz.
Intel 486DX2, 50 or 66MHz.
Intel 486DX4, 75 or 100MHz.
Intel 486 DX2 3.3V Support.
Intel Pentium OverDrive Processor.
486 OverDrive Processor.
Cyrix DX2/80 or DX/40.
AMD DX40, DX2/80, or DX4/100.
AMD SX, 25 or 33MHz.

Expansion One proprietary slot supports VL-Bus or PCI R
card (slot configuration varies depending on ca
design).

Chip Sets Micronics X30 single chip ASIC.
CMD 640B Mode 3 Localbus IDE controller.
SMC 665 Super I/O.

RAM Capacity 128MB.

Form Factor Mini AT footprint (8.5" x 9.5").
4 Layer PCB.

Keyboard PS/2 compatible.

Mouse PS/2 compatible.

BIOS Phoenix BIOS on 1MB Flash EPROM.

Cache 8K of internal cache memory (may vary).

Cache Upgrade Optional 256K or 512K of secondary cache
memory (write-through or write-back).

D
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Built-in Video ATI 68800 mach64 LX.
1MB DRAM frame buffer.
Resolutions Supported:

640x480 (65,536 colors).
800x600 (256 colors).
1024x768 (256 colors).
1280x1024 (16 colors).

I/O Ports Built in support.
Two serial ports.
One bi-directional parallel port.

Enhanced Parallel Port (EPP) compatible.
Microsoft and Hewlett Packard Extended
Capabilities Port (ECP) compatible.

Floppy Port Supports two floppy drive (2.88, 1.44, 1.2, 720K, 360K).

IDE Support Supports two IDE hard disks.
LBA support.

Burn-in 48 hours (minimum).

SoundDrive 16 Controller Specifications

Features Full compatibility with the following sound and multimedi
standards:

m    Sound Blaster.
m    AdLib.
m    Microsoft Windows Sound System.
m    MPC Level I and II.

 Chipsets ESS688 Audio Drive.
Yamaha OPL3 FM Synthesis.

Interfaces DB-15 port for Joystick/MIDI Port.
3.5 mm mono jack for microphone input.

. 3.5 mm 4W amplified speaker output.
3.5 mm stereo jack for line input.
3.5 mm stereo jack for line out.
D-2
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Additional FM Synthesizer
Features 20-voice Stereo Synthesizer.

Stereo Digital/Analog Mixer (built-in)
Selectable input and mixing of all audio sources
recording:

Line-in.
Stereo CD-Audio.
Mono Microphone.
Synthesizer.
Digital Audio.

Stereo Digitized Audio Playback
8-bit and 16-bit sample modes.
Sampling Rate of:

2KHz to 44.1KHz (mono or stereo) .
Hardware audio decompression ESPCM (ratios
2:1, 3:1, and 4:1).

Audio Amplifier
Frequency Response: 20Hz to 22KHz.

Stereo Digitized Audio Recording
8-bit and 16-bit sample modes.
Sampling Rate of 2KHz to 44.1KHz.

MIDI
Sound Blaster type Joystick/MIDI cable.

Joystick Port/MIDI Interface
Standard built-in (15-pin D-sub) connector.
Game I/O  port for PC analog joystick.
Built-in interface for Sound Blaster MIDI cable.
with MIDI IN and MIDI OUT connectors.
MIDI time-stamp for Multimedia extension.
Sound Blaster MIDI compatible.
64-byte FIFO buffer.

Mono Microphone Input
Automatic Gain Control for direct sound input.
D-3
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14,400 Fax Modem Module Specifications (Optional)

Data Mode V.32bis:  14400bps/9600bps/4800bps.
V.22bis:  2400/1200bps.
Bell 212A:  1200bps.
Bell 103:  300bps.

Fax Mode V.17:  14400bps transmit and receive.
V.29:  9600/7200bps transmit and receive.
V.27ter:  4800/2400bps transmit and receive.
V.21 channel 2:  300bps transmit and receive.

Transmit Level -10 dBm.

Receive Level -10 dBm to -43 dBm.

Command Set Extended AT command set.
EIA-578, Service Class 1 commands.

Profile Storage NVRAM allow storage of two user configurations and fou
36-digit dial string.

Miscellaneous Supports software V.42/MNP2-4 andV.42bis/MNP5.
Communication software compatible.
Automatic adaptive/fixed compromise equalization.
Full-duplex data mode test capabilities:
              Analog loop, local digit loop, and remote digit loo
D-4
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Specifications
Environmental Specifications

The environment where the LPX30WB is located is critical.  Micronic
recommends the following environmental specifications:

Temperature Range

Operating:  50 to 104 degrees Fahrenheit (10 to 40 degrees Celsius)

Non-Operating:  50 to 140 degrees Fahrenheit (10 to 60 degrees Ce

Shipping:  -22 to 140 degrees Fahrenheit (-30 to 60 degrees Celsius

Relative Humidity

Operating:  20% to 80%.

Non-Operating:  5% to 90%.
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Battery Disposal

Warning:
DO NOT: open battery; dispose of in fire; recharge; put in backwards, mix
with used or other battery types.

May explode or leak and cause personal injury.
D-6
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Installing a Power Module

The LPM30 will accommodate a large variety of 486 processors.  W
installing a 5.0V processor, locate J21 on your system board (see Fi
2-1), and configure it as shown below (Figure E-1).

Figure E-1  Configuring Jumper J21

To configure your system board for a 3.3V or 4.0V processor, you wi
need to order a Power Module.  If you do not have one, contact
Micronics’ Customer Service department at (510) 651-2300.

Note:
The Power Module partially obstructs SIMM Socket U45 (bank 3).  If
installing a SIMM in this socket, it is recommended you install the
SIMM prior to installing the Power Module.

If the Power Module is already installed, you will need to temporarily
remove it to install the SIMM.

E
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To install a Power Module, remove all jumpers from Jumper J21 and inst
as shown below (Figure E-2).

Figure E-2  Installing a Power Module

After you have installed the Power Module, secure it with a tie strap (Figu
E-3) and your installation is complete.

Figure E-3  Securing the Power Module
E-2
Click here to continue
to the next chapter.....
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Glossary

BIOS: Basic Input Output System.  Maintains and controls the
entire functions of the computer.

Cache: Fast memory used to enhance the efficiency and speed o
computer.

CPU: Central Processing Unit.  Essentially, the “brains” of the
computer.

Disk Drive: Either a hard disk or a floppy diskette.

DRAM: Dynamic Random Access Memory.

EISA: Extended Industry Standard Architecture.

ISA: Industry Standard Architecture.

Jumpers: A device on the system board used to configure certain
information on the board.

POST: Power On Self Test.  The computer’s self-diagnostic test
which is executed whenever the system is booted.

Setup: Steps used to configure the system board.

SIMM: Single In-line Memory Module.  SIMMs are banks of
memory used to increase the performance of the comput

SRAM: Static Random Access Memory.
Click here to continue
to the next chapter.....
G-1



 are
 a
adio

 or
n.
f the

at

p.

.

 the
FCC Warning Statement

This equipment has been tested and found to comply within the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules.  These limits
designed to provide reasonable protection against harmful interference in
residential installation.  This equipment generates, uses and can radiate r
frequency energy and, if not used in accordance with the instructions, may
cause harmful interference to radio communications.  Interference to radio
television reception can be determined by turning the equipment off and o
The user is encouraged to try to correct the interference by one or more o
following measures:

M Reorient the receiving antenna.

M Increase the separation between the equipment and the receiver.

M Connect the equipment into an outlet on a circuit different from th
to which the receiver is connected.

M Consult your dealer or an experienced radio/TV technician for hel

To meet FCC requirements, shielded cables and power cords are required

Note:
Changes or modifications not expressly approved by Micronics could void
user’s authority to operate the equipment.
Click here to continue
to the next chapter.....
F - 1



m
) year
is
,

r or

r
t or

 by
nt,

t
 or
le
to

s
 can

ped
 or
, will

ould
hen

t
r
ntract
f

Limited Warranty

Except as described below, Micronics warrants the products to be free fro
defects in material and workmanship in normal use for a period of one (1
from date of purchase.  Should any product fail to perform according to th
warranty at any time during the warranty period, except as provided below
Micronics or its authorized service centers will, at Micronics’ option, repai
replace the product at no additional charge.

The warranty does not cover loss or damage which occurs in shipment o
which is due to: (1) improper installation or maintenance, misuse, neglec
any cause other than ordinary commercial application, including without
limitation, accidents or acts of God; (2) adjustment, repair, or modification
other than a Micronics authorized service center; (3) improper environme
excessive or inadequate heating or air conditioning, or electrical power
failures, surges or other irregularities; (4) any statement about the produc
other than those set forth in this warranty; or (5) nonconformity to models
samples shown to the purchaser. Any models or samples were for the so
purpose of suggesting the character of the product and are not intended 
form the basis of the bargain.

A receipt or copy of the invoice with the date of purchase from a Micronic
reseller is required before any warranty service can be rendered. Service
be obtained by calling Micronics for a Return Merchandise Authorization
(RMA) Number.

The RMA Number should be prominently displayed on the outside of the
shipping carton of the returned product. Returned product should be ship
prepaid or hand carried to Micronics. The purchaser assumes risk of loss
damage in transit, and unless otherwise agreed to in writing by Micronics
pay inbound shipping charges.

The exclusive remedy of the purchaser under this warranty above will be
repair or replace at Micronics’ option, but if for any reason that remedy sh
fail of its essential purpose, the exclusive remedy of the purchaser shall t
be actual damages up to amounts paid for the defective product by the
purchaser. This limited warranty shall be deemed to “fail of its essential
purpose” if, after repeated efforts, Micronics is unable to make the produc
operate as warranted.  Micronics’ liability for damages to the purchaser fo
any cause whatsoever; regardless of the form of action and whether in co
or in tort, shall be limited to the purchase price in effect when the cause o
action arose for the product that is the basis of the claim.
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Micronics will not be liable for any lost profits or any indirect, special
incidental or consequential damages in connection with the product, eve
Micronics has been advised of the possibility of such damages.

Micronics makes no warranties or representations as to performance of
products or as to service to distributor or to any person, except as set for
Micronics; limited warranty accompanying delivery of product.

Micronics disclaims all other warranties whether oral, written, expressed,
implied, including without limitation, the warranties of design, merchanta
ity, or fitness for a particular purpose, if applicable, or arising from a cour
dealing, usage or trade practice.

Non-Warranty Service

After the one year warranty service is no longer in effect,  service is still
available for Micronics products.  For more information, contact Micronic
RMA department at (510) 683-0428 or (510) 683-0545.  The RMA depar
ment is open between 8:30 A.M. and 5 P.M. Pacific Standard Time.
W-2
Click here to continue
to the next chapter.....



User's Comment Form:  LPM30

What do you like about this manual?

What would you change in this manual?

Mail comments to:
Micronics Computers, Inc.

Technical Publications Department
232 E. Warren Avenue
Fremont, CA  94539

Name: _____________________ Dealer:_________________________
Title: ______________________ Date:___________________________
Company: __________________ Telephone: ______________________
Address:_____________________________________________________
____________________________________________________________


